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Welcome to the latest 
issue of Advanced 
Photoshop. Design 
inspiration can be a bit thin 
on the ground at this time 
of year, but 2013 has been 
consistently serving some 
of the best work ever seen. 

IN THIS ISSUE:

GRAPHICS
DIGITAL PAINTING

PHOTOMANIPULATION
PHOTO EDITING

ANNA�LISA SAYWELL
Editor

So with that in mind, we bring you a great selection 
of inspirational work this issue, including our cover 
feature on pro retouching and working within the 
commercial image industry, professional tips on 
how to master informative and visually appealing 
infographics, and how to design a commercial-
standard webpage in Photoshop. 

Elsewhere in the issue, work with custom 
brushes to paint fantasy lighting and learn expert 
compositing tips with our fashion illustration 
tutorial. We also chat to FZD School of Design about 
the Asian concept market, and review Dell’s new 
XPS One 27 touch screen all-in-one to let you know 
if it lives up to its hype.

Last, but by no means least, we have compiled a 
selection of great content on this month’s disc, 
including two exclusive video tutorials, 40 premium 
images, fonts worth $60, Photoshop brushes and 
much, much more. Enjoy! 

FIND US ONLINE:
@advancedpshop /AdvancedPhotoshop

.co.uk
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Photographer Yulia 
Gorbachenko’s stunning 

imagery is our top choice 
for the cover. Additional 

credits: make-up Frances 
Hathaway; retoucher 

Cristian Girotto; model 
Vanessa Cruz at 

IMG Models

YULIA GORBACHENKO
www.yuliagorbachenko.com
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EYE ON DESIGN    PRO PANEL

PRO PANEL
OUR CONTRIBUTORS SHARE THEIR PHOTOSHOP SECRETS, EXPLAINING HOW THEY 
CREATED THESE STUNNING EFFECTS USING SPECIFIC TOOLS AND TECHNIQUES

EYE ON DESIGN

THERESE LARSSON
www.sillybeastillustration.com
In order to create a compelling painting, sit down before you start and 
think about the actual idea. Try to give your image some kind of back 
story that adds emotional value. When the audience looks at your art, it 

should make them think, laugh, feel sad or get excited. The best art moves people in some 
fashion or another.
■ Larsson reveals how she used Photoshop to create authentic lighting on page 72

MARCO NELOR
www.thurd-eye.blogspot.co.uk
One way to save time and keep an image organised 
is to lock layers. The overall shape of this stealth 
bomber was applied with a solid black colour, on a 

separate layer. Then the layer was locked. This allowed me to paint 
within the borders of the shape without going over the edges.
■ Nelor’s fantasy painting secrets are unlocked on page 52

RASMUS WANGELIN
www.rasill.com
I use a lot of adjustment layers, such as Gradient Maps, to control highlights and shadows. I also use Hue/Saturation to adjust colours. I often end 
up applying a good deal of these adjustment layers to small parts of an image, fine-tuning these individually. Adding sharpness and image blur is 
also a great way to make even the smallest detail stand out. 

■ Learn how to create photo-based web styles in Wangelin’s tutorial, beginning on page 62

© Rasmus Wangelin

© Marco Nelor© Therese Larsson
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MAXIME GIRAULT
www.maximegirault.com
Use Smart Objects to modify elements. I did in this image, where I wanted to change the 
design of the giant wheel. I created a new layer with a circle shape, Ctrl/right-clicked the 
layer, then converted it to a Smart Object. By applying the Transform controls, I was able to 

enhance this circle as much as I wanted when double-clicking on the Smart Object.
■ Girault blurs the boundaries between photo and illustration in our How I Made, starting on page 58

In order to create 
a compelling 

painting, try to give 
your image some kind 
of back story that adds 
emotional value

VESNA PESIC
http://becha.me/
Keep complex Pen tool illustrations flexible by selecting all layers, Ctrl/right-clicking, then 
selecting Convert to Smart Object. Now you can apply layer styles to everything, as if your 
shapes were one whole layer. Go to Layer>Smart Object>Edit Content and in a separate 
temporary file, edit layers as if they were separate once more. 

■ Discover Pesic’s fashion illustration techniques in her tutorial over on page 42

© Maxime Girault

© Vesna Pesic
THERESE LARSSON / 
SILLYBEASTILLUSTRATION.COM
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eye on design    portfolio interview

João oliveira of onrepeat studio discusses his philosophy 
on the world of typography and his approach to it

portfolio interview

EyE-catching 
typography

http://onrepeat.net
@On_Repeat

F or João Oliveira, words needn’t be dull. 
Through the bold use of light, colour and an 
imaginative approach to typography, his 
creations leap off the page; the exciting and 

eye-catching aesthetic of the words saying almost as 
much as – if not more than – the words themselves.

It didn’t start out like this for Oliveira, though; his 
early education initially led him down a very different 
path. “My education was largely science orientated. I 
never thought too much about studying art or 
becoming a professional creative until very late on,” 
he tells us. “I spent most of my school time studying 
science, and actually wanted to become a biologist.”

However, this interest in the world of living things 
soon morphed into a love of design and a love of 
living words. Oliveira has established a distinctive 
style over the years, and whether he’s creating a 
neon-tinged logo or a phrase built out of bricks and 

mortar, you can tell it’s his hand behind the work. 
“It’s extremely important to have some sense of 

identity and personality,” says Oliveira. “Most 
established illustrators and designers are well-
known not because they’re great all-round creatives, 
but because they do some specific kind of work 
extremely well. They might have a body of work 
containing a wide range of styles, but they tend to 
excel in something very specific; something that 
makes them stand out from the crowd. For example, 
I market myself as someone who creates 
typographic illustrations and uses vibrant colours 
and lights. That’s my business card.

Can you tell us a little about yourselF 
and your history as an artist? 
I’ve been a creative person for as long as I can 
remember. Creativity was a big part of my childhood, 

and I used to love drawing. In fact, most of my 
drawings were intricate to the point of having no 
more room to draw! That might explain why my 
illustrations are so detailed. 

I also remember creating my own editorial 
projects as a kid. I used to make homemade 
magazines from scratch; I created the content and 
assembled the magazine with glue and some of 
them even had a hard cover. Their themes ranged 
from dinosaur guides where I illustrated and wrote 
the descriptions of the various species of dinosaurs 
(yes, I loved dinosaurs and still do) to game 
magazines with lots of puzzles like word soups and 
so on. 

During high school, I had my first experiences 
with design and started experimenting with 
Photoshop and Illustrator. After some months, I 
began making money by creating my first logotypes 

01

01
Coca-Cola – Camarata: ensuring that 
images are clean, readable and 
eye-catching is key when working with 
brands such as this © João oliveira

02
Smooth: successful typography should 
sell its concept through both the word 
and the imagery, tying both together on 
a thematic level © João oliveira

03
Mementos: oliveira doesn’t work 
exclusively in typography, with his work 
straddling a broad range of styles and 
aesthetics © João oliveira
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eye on design    portfolio interview

and website layouts. I didn’t earn too much, but that 
was the defining moment that made me realise that 
I really wanted to be a designer and even better, I 
could make money by doing something that I really 
loved. I made the decision to study design, and just 
after finishing high school I applied to do a 
Communication Design degree. I’ve been working as 
a freelancer since that moment and I’ve been lucky 
enough to have no need to work on any other job.

How did you start getting accustomed 
to PHotosHoP’s various design tools 
and oPtions?
It all came very naturally. I got accustomed by 
reading the kind of tutorials we all do when we start 
using Photoshop. I eventually started experimenting 
with the tools by myself, creating my first designs 
that, if I remember correctly, were mostly space 
scenes with planets and star fields. They were very 
popular back then! 
  As time passed, I became increasingly familiar with 
the Photoshop tools and felt comfortable enough to 
experiment with new styles and create my own 
choice of compositions.

wHere do you find tHe insPiration for 
your work?
I’m a huge sponge; my brain needs to be constantly 
stimulated, so I leech inspiration from everything 
around me. I love being adventurous and I seek 
pleasure and excitement. I travel to new places, 
explore antique shops full of retro items, meet new 
and interesting people or simply flick through 
magazines and find interesting lettering. Having a fed 
brain is what keeps me inspired and motivated to 
create new work!

How do you ensure your work feels 
fresH and different from your Peers?
Every time I start developing a new project, I spend a 
lot of time researching what has already been made 
and what I can do to create something new and 
fresh. This phase is very important. I love a good 
challenge, so when I begin a new project, I set a new 
one for myself. Why create something that has 
already been done? What kind of twist can I give to 
this piece to make it unique? Usually, this sense of 
identity comes through my use of vibrant colours 
and lighting.

wHat is your aPProacH to tyPograPHy?
I love typography and creating whole worlds around 
the letter forms. I spend a lot of time researching 
what has been created in the past; there’s a lot of 
visual brainstorming and I’m always full of ideas, so 
usually I have the entire image already planned in my 
head before I actually start making it. It’s all a matter 
of picking the right idea and translating that onto the 
screen. During the selection process, I always tend to 
think about the same questions; namely, has anyone 
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06
Medieval: Creative typography doesn’t 
always mean experimenting with the 
shape of the words – you can almost 
make the word an image in and of itself  
© João oliveira 

05
King Of Hearts: digital Abstracts asked 
oliveira to create a King of Hearts card to 
be part of their Creative Cards deck, 
along with 53 other invited artists  
© João oliveira

07
Kult Magazine: oliveira was asked to 
illustrate this phrase for an independent 
singaporean magazine © João oliveira

04  
TMN – e: oliveira has worked with a 
number of brands over the years, always 
finding interesting ways of incorporating 
his own look with the client’s values  
© João oliveira  
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made this before? If yes, what can I do to make it 
even better? 

After this phase, I tend to search for graphic 
elements that could be used in new and unique 
ways. For example, in my Smooth piece, I had to 
search for brass instruments that could be blended 
with the lettering.

How do you ensure your ideas meet a 
client’s demands? 
Understanding the client’s brand values and 
personality is the most important starting point in 
any project. A solid understanding of how the brand 
talks to the outside world and what could be done to 
improve that interaction is the next step. It’s all about 
solving a problem, so it really depends on what the 
client is asking.

do you find it a cHallenge to maintain a 
sense of identity wHen working witH so 
many different brands?
It’s definitely harder to inject my own identity into 
branding projects, since each brand has their own 
language. The way I react to their demands and solve 
their problems is different from project to project, but 
I always try to worship typography in all my pieces, 

and create typographic elements and custom 
typography whenever possible.

How do you strike a balance between 
commercial and personal work?
Personal projects are as important as the 
commercial ones. They are my own playground, 
where I can have fun experimenting with new styles 
that may later be used on commercial projects. 

That’s how all my styles were born; by experimenting 
on personal pieces that were then noticed by clients 
who wanted those styles translated into their brands.

wHicH artists and designers Have Had 
tHe biggest influence on you? in wHat 
ways did tHey influence your work?
Stefan Sagmeister and more recently Jessica Walsh 
are two creatives that I really admire; not just 
because of the exceptional work that they produce, 
but simply because of the way that they approach 
their work. It’s all about having fun and enjoying what 
we do, being really passionate, persistent and 
curious and always willing to challenge ourselves. 
That’s what makes our work enjoyable for others, 
and I really admire any artist who approaches their 
work like that.

wHat would you say is tHe most 
important tecHnique you Have learned 
in pHotosHop?
For me, mastering the creation and blending of light 
and colours was definitely the most important 
achievement in my career as a designer. Creating 
bright, colourful lights with lots of glow is what 
started it all!

■ analyse tHe market  
Certain styles are more suited to commercial projects than 
others. Do your research before developing an aesthetic 
and ask yourself how a brand could use that look to 
advertise itself.

■ tHink about tHe goal of your portfolio 
What brand do you aim to work for? What kind of clients do 
you want? What are you trying to achieve? Develop your 
style based on these goals, and build an overall look that 
suits the clients you aspire to work with.

■ be passionate  
Figure out what you’re really passionate about and what 
kind of work you want to do, then do it. When you enjoy 
doing your work, you’ll excel at it and people will notice. 
Challenge yourself, be persistent and have fun!

portfolio tips
Oliveira Offers sOme insight intO creating a 
memOrable bOdy Of wOrk

08

Tiger Beer: bold use of light and colour 
is one of the key aesthetics in Oliveira’s 
work, as witnessed in this striking 
image © João Oliveira
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Patrick Bras on creating an underwater world to celeBrate sPanish 
swimming and Promote the Fina world chamPionshiPs

project FocUS

Creative retouChing

FINA is the world governing body for five 
aquatic disciplines including swimming, 
diving, waterpolo, synchronised swimming 
and open water. To promote the 2013 World 

Championships held in Barcelona, creative retoucher 
Patrick Bras was brought on board with art director 
Fer Garcia at TBWA Barcelona and photographer 
David Ruano (www.davidruanofotografia.com) to 
create an underwater spectacle for use in its 
campaign. This would celebrate the inspiring 
Spanish athletes and the city they were set to 
compete in. The project started out as a rough 
mock-up, showing ideas of locations, positioning of 
athletes and the general mood of the images, and 
then the three set out to make the idea a reality, with 
Patrick in the driving seat of seamlessly blending 
photography and manufacturing perfect lighting. The 
series of images have been used in a vast amount of 
applications. At first, they were used online on the 
event’s official website. When the campaign was 
launched this spring, the images were placed 
throughout the city on bus stops, buildings, banners 
and posters.

Can you walk us through the proCess 
of shooting these images and putting 
the Composition together?
David Ruano shot various modern locations in 
Barcelona in evening sunlight and they all needed 
some work before the athletes were added to them. 
Some images we used almost as they were shot, 
others had to be stitched from multiple captures or 
elements had to be moved to fit the layouts.

With these images, I used the automatic 
Photomerge function in Photoshop. I always ask my 

photographers to turn the camera slightly up and 
down and left to right, to be sure we have enough 
bleed in case the client asks for more than the 
original camera view. When shot from the same 
camera position and if the camera movement is not 
that much, Photoshop does a good job at stitching 
the images together.

Second, I worked on the athletes. All were shot in 
the studio with a similar light to the one we used in 
the background images. These were kept as simple 
as possible, which made it easier to cut out the 
people. Some retouching was done on the 
swimwear and skin, but not much – we wanted to 
keep the athletes as realistic as possible.

The third step was putting both elements together, 
searching for the correct proportions, adding the 
‘water ceiling’ and inserting elements such as 
shadows. The final step was the overall colour 
grading of the images.

the images all have a very speCifiC 
feel. how did you use lighting to 
aChieve this?
The feel and mood of the images already had a 
strong direction in them because of the choice of 
light. An evening sun gives an image a lot of 
atmosphere. I enhanced this golden mood and 
combined it with the blue-green tone of the water 
ceilings we added to the images. This resulted in the 
specific feel that I was able to apply to all images of 
the campaign.

Can you elaborate on the lighting 
effeCts you used?
I work with adjustment layers like Curves, Levels 

Patrick Bras is a Dutch creative 
retoucher based in Barcelona. He 

studied Graphic Design in 
Rotterdam, Photography in Utrecht 

and Ghent (Belgium) and worked 
for four years as the assistant of 
renowned photographer Erwin 

Olaf. Since 2006, he’s been running 
his own retouching studio, Eclipse 
BCN, and working for a variety of 
clients worldwide such as Adidas, 

Nike, BMW and SEAT.

Patrick Bras, 
EcliPsE BcN

about the studio

www.eclipsebcn.com

BcN FiNa 2013 World 
chamPioNshiPs 

camPaigN

name of projeCt

040014
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and Hue/Saturation combined with blend modes to 
get to the general mood I am looking for. For 
masking, I prefer to work with a Quick Mask and 
brushes instead of paths. This allows me to follow 
the sharpness and blurriness of the image. I get 
better results especially when working with organic 
forms like bodies.

When I have reached a mood I like, I start 
fine-tuning it. This process is not technical but more 
intuitive – I always compare it to painting. I add 
shadows, highlights and light accents and paint them 
in until I ‘feel’ the image is done. The technical part of 
it is that this process has to be repeatable to be able 
to do the same to the other images in the series, 
making it one set.

HOW DID YOU CREATE THE WATER CEILING 
THAT SITS ABOVE EACH IMAGE?
The water ceilings were photographed by David. 
They are underwater shots of a swimming pool and I 
integrated them into the images as a normal layer. 
I tried various blend modes like Soft Light and 
Overlay, but nothing really worked and too much 
detail got lost. I finally ended up using the water 

layers as they were, blending them with the 
background layer by using a Gradient layer mask and 
amending it with a large brush to achieve a 
seamless integration. With a variety of Curves and 
Hue/Saturation layers, I gradually changed the 
colours from aqua to the golden tone of the original 
sky underneath.

WHAT ADVICE CAN YOU GIVE READERS TO 
HELP THEM IMPROVE LIGHTING IN THEIR 
OWN IMAGES?
The best advice is to plan ahead. Get involved in a 
project even before the shoot starts. I prefer to work 
with reference images taken from books or the 
internet to help illustrate what I am looking for. It is 
very difficult to get a good result if you only start 
thinking about these things when you already have 
the input material on your computer.

Play and experiment. Try to find new techniques 
and fine-tune them. When a file becomes too 
complicated or you are destroying the quality of the 
image, don’t hesitate to go back and try it again, 
using your first ‘sketch’ as a base. Try to achieve the 
same result but in a simpler, less destructive way.

© Daniel Ruano Rimbau/FINA 2011

Synchronised swimming

Women’s swimming

Bras favours brushes 
over paths when working 
with the models, as it 
gives him better control 
when following the 
sharpness and blurriness 
of the image

The water ceiling to 
encapsulate the scene 
across the images was taken 
as an underwater shot and 
then manipulated by Bras to 
bring out the golden tone of 
the original sky

Both the background and the model were 
shot under similar lighting conditions to 
enable Bras to create a seamless effect 
between the two, and then more lighting 
was added



F eng Zhu Design (FZD) began as a studio back 
in 2001 and quickly grew into a premium 
Image Property (IP) creator for the feature 
film and videogames industry. This was due 

to a high demand for conceptual design in the 
entertainment arena, which continues to expand. 
“For the past 12 years, we’ve worked on a large 
variety of high-profile projects,” reveals founder Feng 
Zhu. “These days, we’re based in Singapore and 
focus more on in-house IP production rather than 
being an external service studio. Later this year, I will 
be launching a new venture called FZD Media to 
support this service.”

The decision for FZD to work only with IP came 
relatively naturally. Zhu describes the industry back 
in 2001 as “the wild west”, especially in the 
videogame sector. New studios were popping up all 
over the place and they all wanted to make new IPs. 
“Even studio giants such as Electronic Arts (EA) were 
also redirecting their core focus onto original IPs, for 
games such as Dead Space and Battlefield,” explains 
Zhu. “This need for new ones kept our studio busy 
for years,” he adds. 

It wasn’t long until the studio successfully 
expanded into other industry sectors. These included 
film, video, television and toys. Zhu focused his 
efforts on providing three factors – speed, quality and 
industry experience – to promote the studio to clients 
operating in these separate fields. He explains: 
“When these criteria are met, word of mouth travels 
fast within our industry. We expanded into these 
other areas of design.”

Maintaining success then became FZD’s main 
obstacle, which Zhu tackled by “under-promising and 
over-delivering,” This simple phrase can do wonders 
in a studio environment, as he explains: “We never 
over-promise to clients in order to seal a deal. 
Instead, we just focus on delivering cool designs and 
try to always over-achieve what was originally asked 
for. This can put a lot of pressure on myself and my 
team at first, but the result is often a long-term 
contract and a huge network of clients.” He also 
warns never to miss a deadline or lie to cover a 
missed deadline, as this will only cause more 
problems in the long run.

When asked how the work produced for film, 
videogames, toys and television differs, Zhu tells us: 
“In the early stages of pre-production, they’re all 
pretty much the same. We generate a ‘blue-sky’ 

studio interview

Find out how this team oF designers is championing 
concept art in asia by training aspiring artists to supply 
the demand, all with the help oF photoshop

FZD School oF DeSign

eye on design    studio interview
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Industry veteran Feng Zhu founded 
both Feng Zhu Design and the FZD 
School of Design. The school’s core 
focus is to train students for a career 
in the entertainment design industry. 
FZD Media is soon to follow, aimed 
at film and videogame production.

FZD School oF DeSign
About the studio

www.fengzhudesign.com
@FengZhuDesign

Feng Zhu, Founder, Creative Director Ben Mauro, Concept Designer
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phase and disregard things such as required 
technology, budget and difficulty levels.” The FZD 
team just let their imaginations run wild and get 
clients hooked on the ideas presented. This is usually 
the most fun stage for all IP designers. “Once our 
designs get past the initial stages, we start tailoring 
them to specific industries,” Zhu reveals. “For 
example, videogames have technology limitations, 
films often have budget limitations and toys have 
manufacturing limitations.” 

The IP industry moves fast, however, with clients 
always looking for the most vivid and unique 
imaginations. That’s why FZD has recently 
introduced new staff to generate fresh ideas and 
design. “I brought in three professionals from the 

eye on design    studio interview

We never over-promise to 
clients. Instead, we just 

focus on delivering cool designs 
and try to always over-achieve 
what was originally asked for 
Weta Workshop and one from Paris,” Zhu tells us. 
“This is because creating new IP is all about 
invention. Having a great team allows us to bounce 
ideas and manipulate concepts fast.” 

Having notable concept skills and a killer portfolio 
is a must, but other skills and interests are 
important, too. “Here at FZD, we prefer designers 

who are well read and knowledgeable in history, 
science and popular culture,” reveals Zhu. “You must 
also love movies, games, fashion, toys, animals, new 
technologies and anything else that’s deemed 
contemporary or cool. It’s important to be able to 
communicate with designers who share similar 
interests, too.”

But his passing on of knowledge doesn’t end with 
sound bites in interviews. Zhu is one of the few 
professionals to have actively sought an opportunity 
to share their wisdom with other aspiring designers. 
He noticed a major gap in the quality of 
entertainment concept design in Asia back in 2009, 
which led to the founding of the FZD School of 
Design. “Back then and even now, the US and 
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Altered CArbon
CheCk out this illustration Created for the book nuthin’ but MeCh, 
and find out how PhotoshoP was instruMental in its CoMPletion

This book project was developed with a friend who was creating a blog called Nuthin’ But Mech. 
This was then expanded further into a book series, which focused on robotic design. I decided to 
come up with a series of portraits of different types of robots, from future worlds with varying 
technologies and design aesthetics. It was a very fun project to be involved in and I pushed myself 
a lot, using ZBrush and Photoshop to make what you see here. By the end of the project, I’d 
brought my technical skill set up a few levels, which allowed the designs to really stand out. 

04 Detail the image
Layer your images using Overlay, Soft 

Light and Lighten blending modes to make the skin 
feel much more vibrant. You can see how these 
have helped create harsh edge lighting on the left 
side of this face and highlight the saturated red and 
yellow skin tones.

01 ZBrush renDers
 ZBrush was used to sculpt and output to 

a very high resolution. Renders were imported and 
layered in Photoshop, affecting the image with 
Lighten, Overlay and Multiply blending modes. 
These options allow you to quickly create a highly 
detailed design.

02 set up the illustration
Presenting the initial renders on a white 

background looks nice and clean. Sci-fi art is 
typically dark and moody, so using a white 
background implies something futuristic and 
modish. This helps to showcase the design and 
make it stand out.

03 Compile renDers
Some renders are more metallic. I cut out 

around the eyes to really sell the difference 
between organic and robotic areas. At this point, 
everything is detailed, but also really flat. This is a 
positive, as it means I can add all my Photoshop 
techniques to this and create something really nice.

06 speCial effeCts
Curves and other colour adjustment 

layers were used to add a blue tint to the image. 
More photo textures were applied on top using a 
Soft Light blending mode, adding noise. Film Grain, 
Gaussian Blur, Smart Sharpen and Lens Correction 
filters were also added to create chromatic shift.

05 DeCals anD textures
Here you can see a page of the textures 

and decals used to detail the final image. These are 
a combination of personally made logos, barcodes, 
photos of skin textures and hairs from 
photographs of ageing faces. Royalty-free tattoo 
designs were modified and added as well.

Sci-fi art is typically dark and 
moody, so using a white 

background implies something 
futuristic and modish
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A DAY IN THE LIFE 
Zhu takes you through the FZD school oF Design timetable 

10:30 Live presentation
All student works are printed and 

presented on custom-built boards. This setup closely 
mimics real-world studio presentations. 

10:10 earLy morning critique
Here, Thomas Brissot looks over 

the students’ work. Every designer at FZD also 
teaches at our school. 

13:00 production meeting
Every day, the art department will 

get together for a meeting after lunch, pouring over 
daily tasks.

Western European markets completely dominate 
the concept design scene,” Zhu explains. “Japan has 
always been strong, but they’re a self-contained 
industry. Having taught since 1999, I wanted to get 
back into education and focus on the growing 
industry out here in Asia.”

The videogame and film industry is expanding like 
crazy in countries such as China and Korea. In 
Eastern Europe, the demand for quality design has 
also risen. “Having a studio on this side of the globe 
has opened up a lot of doors,” says Zhu. “Especially 
with regards to the investment side of things. These 
countries all want top designers to help them build 
up new IPs.” The FZD School of Design aims to teach 
students how to supply this demand.   

Interestingly, each and every designer at FZD acts 
as a part-time teacher at the school. This directly 
affects the way they now work and what they design 
with. “The MacBook Pro laptops with Retina display 
are perfect for mobility between the studio and the 
classrooms,” Zhu tells us. “In the studio, the laptops 
are connected to external monitors for additional 
displays. In the classroom, they’re connected to 1080 
HD projectors.”

A majority of the work produced at both FZD and 
the FZD School of Design is completed using Adobe 
Photoshop CS6. “All of us basically grew up with 
Photoshop, so we know this software well,” explains 
Zhu. “I started my pro-career with version four.” 
Together with the Wacom tablet, the team can pretty 
much produce any client work using Photoshop. 
Other supporting software they use includes ZBrush 
and SketchUp. 

However, Zhu emphasises that without a doubt, 
Photoshop is the best and most powerful software 
out there to do what he does. “It’s so versatile, 
meaning that we can apply it to any project that 
comes our way,” he admits. “One of the best features 
of Photoshop is its backwards compatibility. For 
example, a brush that I made back in CS1 can still be 

opened up in CS6. This allows our artists to trade 
brushes, shapes and other settings across different 
versions of the software.”

Custom action keys are also endorsed, offering up 
a ton of quick shortcuts to speed up workflow. “I 
mostly use my flip canvas key,” Zhu says. “Flipping 
or mirroring an image is one of the best ways to 
check the quality of a composition.” Zhu also loves 
the Window>Arrange>New Window option in 
Photoshop. “This allows me to have two of the same 
image open at one time. I’ll throw a Full Screen view 
of the image onto my secondary monitor and use 
my main monitor for the zoomed detail work,” he 
explains. “Since the images are updated in real-time, 
I can check both detail and overall effects at the 
same time.”

eye on Design    studio interview

painting based on the book roadside picnic: this image 
started with some pictures of hong kong and various ground 
vehicles. overlay layers were used often to blend photos 
together. color balance and hue/saturation were used to 
balance the overall tone © Feng Zhu, Feng Zhu Design inc

above, death dragon: this is a test painting to demonstrate 
Photoshop’s layer tools. it started with a loose 
black-and-white sketch on a multiply blending mode layer. 
random textures were applied to capture the look and feel of 
the scene © Feng Zhu, Feng Zhu Design inc

One of the best features of 
Photoshop is its backwards 

compatibility. For example, a 
brush that I made back in CS1 
can still be opened up in CS6



17:00 Time ouT
Videogame and coffee time. This is 

a great way to relax towards the end of the day, as 
well as doing some personal research. 

19:30 Done for The Day
At around 7:30pm, Jojo, the 

studio pet, will start bugging me to go home. 
Time to lock up.

021021

14:00 ScheDuling
Meetings with the production 

assistants really help to keep tasks on schedule at 
the school and studio.
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Anton Egorov 
www.behance.net/egorov
Anton Egorov is a freelance Cg 
artist who has worked for clients 

including toyota, Japan tobacco International and 
Saatchi & Saatchi LA. He created this infographic on 
the area and population of Central Asia and Mongolia 

for a client. He explains how to create a theme with 
data: “Usually, after collecting the information, it’s just 
a bunch of facts, some pages of text and a couple of 
fearful tables into the bargain. From this junk, we 
should carefully extract nice and pretty data that we 

want show to our viewer. Ideally, you can describe 
your purpose with one word. But usually it’s several 
ones. In my case, it’s something + something + 
entertainment. Despite that, I still respect fully 
utilitarian infographics.”

Build infographics 
with a theme

© Anton Egorov Client: Japan 
Tobacco International. Agency: 
re:point - Kazakhstan

■ add details
Some of the small details were 
drawn with my tablet pen

■ smoke effects
The black-and-white photo of the 
smoke was used in Screen mode

■ further details
Other details are simple, free 3D 
models rendered in grey and 
coloured with Photoshop

■ landmarks
For famous sights, I made plain 
3D models and textured them in 
Photoshop using photos

■ 3d beginnings
At first, I rendered a simple 3D model of the pie using a plain 
grey material, so I didn’t worry about perspective and shadows

■ add textures
I mixed some textures and photos in 
masked groups and used them in 
Multiply mode above the 3D shot



PROFESSIONAL DESIGNERS SHARE THEIR TOP TIPS FOR CREATING INFORMATIVE AND 
VISUALLY APPEALING GRAPHICS THAT WORK HARD TO REPRESENT THE GIVEN DATA

SABRINA SMELKO
www.sabrinasmelko.com

Sabrina Smelko, illustrator and 
designer, shares her top tips for 

planning an infographic: “The first step to creating a 
great infographic is gathering information – be that 
from a client or not. You need to ask: What’s the 
mood of the infographic? What are the dimensions 
of the piece? What is the style? What medium is it 
being created for? But most importantly, you need 
the statistics. They are the bones that all great 
infographics are based on. The right kind of stats are 
also important: the more direct, the better. Any time 
you can use concrete numbers or percentages, the 
more hard-hitting the graphics.”

HOW TO PLAN AN 
INFOGRAPHIC
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01 CLIENT REQUIREMENTS
I met with the great people at Bright 

Almond over dinner. We chatted about their needs 
and I gathered as much information about the 
project as possible. At this stage, they also supplied 
me with their brand guidelines that specified the 
colours and fonts I had to use, so I could think about 
a look and style to execute in.

02 EXPERIMENTATION
As Bright Almond spent some time fishing 

for statistics, I started playing with styles, shapes and 
the overall look of pieces in Illustrator before diving 
into anything too specific. After this, I was supplied 
with a long list of statistics from which I could pick 
and choose the best nuggets of information.

03 PUTTING IT ALL TOGETHER
Once I established a look, I laid out the 

boxes of soon-to-be text and graphics using a grid to 
ensure the infographic would be visually balanced. 
By this point, I had established a look and a layout, 
gained knowledge of the dimensions, purpose and 
usage of the infographic and was supplied with 
colours and fonts, so it was a matter of filling in the 
blanks. The only task left to do was to translate the 
statistics into icons and illustrations in a visually 
pleasing and educational way.

WAYS TO MASTER
iNFOGRAPHiCS15

JONATHAN QUINTIN
www.dribbble.com/STUDIOJQ

Jonathan Quintin, founder 
and creative director of 

STUDIOJQ, created this screen printed wedding 
invitation infographic to celebrate the lives of a 
couple getting married. He says that you need to 
consider how people will view your infographics: 
“It’s extremely important to consider all media 
types and where the viewer will see your 
infographics. When the big rave for infographics 
started, most designed for a standard web 
format, but these days you need to consider 
animated elements and better ways to tell a 
story. This helps to deliver [the data] in a much 
more visual and interesting way.”

INFOGRAPHICS 
IN A DIGITAL AGE
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Alexis Cuddyre 
www.alexiscuddyre.com 
Graphic designer Alexis Cuddyre 
has worked on data visualisation 

projects for a range of clients through her current 
employer, digit. she tells us: “if the aim of your 

infographic is to tell a story, it’s very important that you 
don’t just include absolutely every single data point 
that you’ve captured. it is the responsibility of the 
team, not just the designer, to make sure the 
visualisation has a carefully curated point of view. On 
the other hand, there are really beautiful infographics, 
especially in the interactive world, where the point of 
the piece is less about explaining a single story and

more about encouraging the user to explore and play 
with the data.” she collaborated with two other 
designers to produce this ‘Notorious James Bond’ 
piece, which was entered into the information is 
Beautiful awards run by david McCandless, a 
london-based author, writer and designer. The full 
interactive piece is available to view at  
http://notoriousbond.info.

Use infographics 
to tell a story
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■ pick an angle
This was based on data released by Information is Beautiful. We looked at the data 
and decided our story was going to be on what each actor was notorious for, be it the 
highest number of kills, or the number of times the actor was presumed dead

■ add context
Last, we added a third level of data along the left-hand side in the 
format of a timeline, where all the movies were listed with their 
respective ratings in order to provide additional context

■ focal design
Each actor was labelled ‘Notorious for…’, which 
influenced the design of the hero image

■ project focus
This image is a single screen from an interactive 
infographic called Notorious James Bond, 
created by Alexis Cuddyre, Christina Winkless 
(www.christinawinkless.com) and David Paul 
Rosser (www.davidpaulrosser.co.uk)
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PAul BuTT 
www.sectiondesign.co.uk

Paul Butt is a freelance designer and has worked 
with clients including the BBC, Wired, Which?, GQ, 

the Financial Times and Ubuntu. When creating an infographic, he 
explains that: “For me, information has the central priority, with graphic 
design playing the supporting role in presenting it. I try to approach 
projects with a rational process and everything has to have a reason for 
being on the page. With that said, there are often little design tweaks 
and flourishes that can be quite subtle, yet can really add character to a 
piece. However, they should not obscure the main point of the graphic.” 

Butt has a set procedure for ensuring that the information doesn’t get 
lost in the design: “I try to work to a defined grid where I’ll lay out a wire 
frame of the information, and then work out how to go about the 
aesthetics. Always question what you are doing and think how other 
people might interpret the work. Getting other people’s opinions can be 
very valuable, as the design should be as accessible as possible.”

prioritise the 
information

026

An earlier prototype for laying out the 
cyclists and the labels. In the end, I had 
much less space than I thought, so had to 
simplify these a lot more to fit in.”

A close-up of the detail, showing how the 
labelling had to fit around the graphic

■ create balance
We included the same amount of supporting 
data on the right-hand side as a secondary way 
of comparing across all the actors

© Section Design
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Jaymie mcammond 
www.jaymiemcammond.com
Designer, illustrator 
and letterer Jaymie 
McAmmond has 

worked for a huge number of well-
known clients. This amazing infographic 
artwork was created as a site-specific 
mural for Starbucks, Toronto, and the 
actual mural stands at 10 x 20ft. It was 
created using mixed media tools 
including pencil, paper, chalk, charcoal, 
Illustrator and Photoshop. 

“When designing this type of mural, I 
begin with sketches to determine 
content, hierarchy of information, 
composition and typography. During this 
phase, I also draw any spot illustrations I 
want to include. Although it might be 
quicker to draw these digitally, I find I get 
more control and accuracy on paper. 
Next, I redraw the illustrations and 
assemble the final composition in 
Illustrator. Lastly, I add texture and depth 
in Photoshop. 

Since Photoshop brushes don’t work 
at this scale, all of my textures are hand 
crafted, scanned and imported as 
separate layers. Although the industry 
standard for printing murals is 
100-150dpi at full scale, I work at 250dpi 
to retain maximum detail in my textures. 
At the end of a project, my files can be 
upwards of 20GB per image before 
flattening – a speedy processor and extra 
RAM can really help with this.”  

One key element of McAmmond’s 
work is the typography: “Not all 
infographics need typography to be 
successful. There are lots of beautiful 
infographics out there that have no 
typography at all. However, I always get 
really excited working with type. 
Choosing the right typefaces is like 
choosing the right cast for a film. The 
information is like a script and the 
typography are the actors that give it 
meaning and bring it to life.” 

Create mixed media infographiCs

© Jaymie McAmmond Tiffany farranT-Gonzalez 
www.tiffanyfarrant.co.uk
Freelance information designer Tiffany Farrant-
Gonzalez has a lot of experience when it comes to 

working with data. Having worked for companies including Google and 
American Express, she says: “The Open Data movement has recently 
seen both countries and large organisations release previously hidden 
data out into the world. This now means that there is a fantastic array of 
sources out there to visualise: from the economy and healthcare to the 
extinction rate and environmental data. The Guardian Datablog (www.
guardian.co.uk/news/datablog) keeps an A-Z list of open data sources 
and Andy Kirk, who runs www.visualisingdata.com, has also compiled 
a fantastic list of open data sources as well as services that work with 
or curate social, map-based, weather and travel data.”

find good data to 
illustrate

anny TruonG 
www.behance.net/anniitron

anny Truong, a graphic designer for april Gold Bags, 
is one of a growing number of designers who have 
applied infographics to their cV as a unique way of 

presenting information about themselves. Truong advises to keep things 
simple: “infographics are meant to present complex information quickly 
and clearly. The last thing you want is to confuse the viewer with 
something that was meant to be simple. Keep it clean, concise and 
visually appealing. a little bit of humour or personality doesn’t hurt either.”

Create an infographiC CV

© Anny Truong

© Tiffany Farrant-Gonzalez

 15 ways to master infographics   Techniques



TECHNIQUES    15 WAYS TO MASTER INFOGRAPHICS

LAWRENCE WHITELEY
www.wond.co.uk    
Lawrence Whiteley is a designer 
and director at Wond. He explains 

that creating an infographic that is easy to understand 
in a glance is “not as crucial as designing something 
people feel is worthy of a glance. A captivating design 
whets the appetite for soaking up the information. If 
you give the viewer curiosity then you have a hook, 
opening us up to learn.” In order to achieve this, he 
advises: “A hierarchy of design helping the viewer to 
navigate and a nice amount of breathing room are a 
solid foundation, but it would be nothing without a 
seductive colour palette and some graphic flair. 
Overcrowding will put people off.”

CAPTIVATE YOUR 
AUDIENCE

© Wond Ltd 2013

INFOGR8
www.infogr8.com
infogr8 designed this quirky 
infographic based on a survey by 

GetLenses. The agency was tasked with creating a 
visual story reflecting the frustrating problems 
glasses wearers suffer in 2013. The design proves 
that infographics can be fun: “The data doesn’t have to 
always be serious, but it must be accurate in order to 
hold integrity. Each project has different objectives, 
audiences and formats to consider. The way we 
approach the data needs to reflect that each time, with 
open, fresh and innovative thinking.”

The company has some essential advice when it 
comes to introducing humour: “It’s crucial that the 
data never gets lost in the design, regardless of the 
angle you’re taking. Without being able to grasp the 
subject at hand straight away or at least have a basic 
understanding of it, you’ve just created an attractive 
piece of graphic design. However, with this specific 
infographic we were given a bit more freedom by the 
client and therefore decided to go with a more playful, 
humorous direction that fitted the target audience and 
the message we were trying to convey.”

INJECT HUMOUR 
INTO INFOGRAPHICS
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© Produced by infogr8, illustrated by 
infogr8’s Stavros Siamptanis

RANDY KRUM
www.infonewt.com
Randy Krum is a well-known name in the world 
of infographics, as the man behind www.
coolinfographics.com, a collection of the best 

infographics around. He is also the president of InfoNewt, an 
infographic design and visual consulting company. He explains why 
infographics are so appealing: “The science behind why infographics 
work is very compelling. The Picture Superiority Effect states that 
audiences are likely to remember 65 per cent of the content 
presented if the text is combined with visuals to convey the message. 
Compare that number to only ten per cent remembered by audiences 
from text alone, and it’s clear that this is a huge advantage to anyone 
that uses information design to tell a story in an infographic.” 

Krum explains how a designer should approach data if they are 
looking to create an infographic for the first time: “Design infographics 
to tell a story really well. Most readers will only look at one for five to 
ten seconds, and not at the whole thing. An infographic designer 
needs to focus on communicating the main message of the design in 
that short amount of time in order to successfully reach most of the 
audience. Don’t include extra data just because it’s available, as that 
will confuse and clutter the design.”

DON’T FORGET THE DATA

© 2010 InfoNewt, LLC, Design 
by Randy Krum
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Gary Corr 
www.garycorr.co.uk
One difficult thing to achieve 
with infographics is balancing 

lots of information in one artwork. This is something 
that Gary Corr has achieved in his CV project. The 
majority of the work is based on typography, so it 
was important to get all the elements weighted 
correctly for it to work. “Typography played a huge 
part in my CV. This was like a sort of cover letter for 
me, but using nice typography. I also made it into a 
nice piece of visual art. I wanted to create something 
that was bold and stood out, creating a memorable 
style that communicates quite strongly. A fair bit of 
planning was involved: first, you need to decide 
which information is going into the CV. As well as the 
usual CV info, I wanted to include some lighthearted 
facts that would paint a picture of my personality. 
Also, I spent time researching others that had been 
already done. I wanted to create an original layout 
that I hadn’t seen before which would stand out. I 
used an unusual shape and fold to achieve this.”

Stand out from 
the crowd

© Gary Corr 2013

Gary’s infographic CV has an original layout 
that folds down small so that it is easy to 
carry around for networking purposes

Thinking outside of the box will make Corr 
stand out from the many other CVs received 
by design agencies every day – a definite 
edge as a recent graduate

Kim GlazebrooK 
www.kimberleyglazebrook.co.uk

Kim Glazebrook is a graphic 
and web designer, and she 

created this infographic for NHS 5 boroughs to 
help young people deal with depression. When 
working for clients like the NHS, it is important to 
make sure that your facts are correct when 
creating your design: “With an infographic, and 
especially this one, it is vitally important to check 
the data is correct, as providing incorrect advice 
could be very harmful.”

alwayS check 
your factS

© Kimberley Glazebrook and NHS 5 Boroughs Partnership
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John Pring 
www.designbysoap.co.uk
John Pring is the 
director of Inbound 
Marketing and Content 

Creation at Designbysoap. He explains the 
importance of making an infographic easy 
to share so that it has the widest reach: 

“Ensure the page you publish the 
infographic on has social media sharing 
buttons, making it easy for the reader to 
share the content. You can include any 
number of social platforms for a user to 
engage with, but I would certainly 
recommend including Twitter, Facebook, 
Pinterest, StumbleUpon and Google+.

Include a HTML embed code with your 
infographic, to allow people to copy and 
paste the code to embed the infographic on 
their own site. An added benefit of this is 
that you can include a credit link back to 
your own site in the embed code, sending 
in more traffic.

In order to encourage sharing, you need 
to think about three main elements; the 
data, the design and the subsequent 
promotion of the artwork. 

The data is integral to the success of 
your infographic, as it is the angle from 

which you decide to approach the 
information. The data should be at least 
one of three things: informative, 
educational or entertaining. Similarly, the 
story is hugely important – much like a 
journalist does, it’s better to approach and 
visualise the data with a story in mind.

The design is a crucial part of 
encouraging sharing – you can have the 
most interesting data in the world and a 
great angle to approach, but if the design is 
poor then you’ll struggle to effectively 
promote the infographic and will be unlikely 
to see much engagement in the way of 
social media sharing. 

Lastly, the way in which you promote 
and spread your infographic will 
dramatically affect how it’s shared across 
social media platforms. Publishing an 
infographic on your site and submitting it to 
a few infographic submission sites will 
likely result in only a handful of social 
shares, whereas approaching an influencer 
such as Mashable and getting your design 
published on their site will almost certainly 
give you hundreds (if not thousands) of 
social shares.”

© Official Charts Company and Designbysoap Ltd, 2013

Michelle 
hyeMin lee 
www.milee.co
Michelle Hyemin Lee created 

One Beverage, an infographic that visualises the 
process of making a drink using an espresso 
machine. Information is delivered in a circular 
graph to resemble both a cup and a clock, and is 
based on Starbucks Coffee Company’s Masterna 
espresso. An important part in the creation of this 
graphic was a relevant and simple colour palette: 
“When designing One Beverage, I selected 
colours in a subtle range of browns and warm 
greys to visually suggest the topic and contribute 
in efficiently organising and delivering the 
information. Subtle and neutral colours are 
chosen not only to visualise, but also help the 
viewer to easily read and understand the 
information. I believe that choosing a relevant 
and effective colour palette is one of the most 
crucial tasks when designing an information 
graphic, because it is a dominant communication 
tool. It can effectively suggest the content at 
glance. An irrelevant or eyesore colour palette 
can repel the viewer from reading the 
information or convey the wrong message.”

pick the right 
colour palette

© Michelle Hyemin Lee

TeCHniques    15 ways to master infographics



Focal Press and You.

BOUND TO CREATE

Save 20% on all Focal Press books when ordering from  
www.focalpress.com. Use discount code PHOTO at checkout.  

ADOBE PHOTOSHOP 
CC FOR 
PHOTOGRAPHERS 
MARTIN EVENING  
Written by a renowned 
professional photographer for 
photographers, this bestseller 
has been fully updated, packed 
with professional examples, step-
by-step tutorials, and 750+ colour 
images. The accompanying website 
features sample images, tutorial 
videos, and more! 
9780415711753 • £29.99

PHOTOSHOP CC:  
ESSENTIAL SKILLS 
MARK GALER &  
PHILIP ANDREWS   
Combining real world examples, 
step-by-step projects, and 
professional advice, this book 
and its companion website (with 
10+ hours of movie tutorials and 
supporting files!) provides the 
ultimate learning experience 
for beginner to intermediate 
Photoshop users.
9780415715713 • £27.99

HOW TO CHEAT IN  
PHOTOSHOP CC  
STEVE CAPLIN  
Learn all the techniques you need 
to create and master the art of 
photomontage, delivered in easy 
to follow step-by-step tutorials by 
master artist Steve Caplin. The 
book’s popular website delivers 
even more resources such as 
video tutorials, an “Ask the Author” 
forum and more!
9780415712385 • £27.99

FOCUS ON 
PHOTOSHOP 
LIGHTROOM
DAVE STEVENSON &  
NIK RAWLINSON
Learn the fundamentals of 
Lightroom and how to use the 
different Lightroom modules: how 
to import, organize, and sort your 
photos, edit them, create a book, 
video clips, or a slideshow, and how 
to make a great print.
9780415663236 • £12.99
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PROPRO

DISCOVER EVERYTHING YOU NEED TO KNOW ABOUT A DIGITAL FASHION 
DESIGN WORKFLOW, FROM SKETCH TO PHOTO SHOOT TO RETOUCH
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T
he world of fashion employs a host of 
digital artists, all of which are tasked 
with creating visuals that promote 
beauty and clothing. It’s an art form in 
which digital illustrators and retouchers 

use Photoshop to achieve otherwise impossible 
results – designs that form the basis of colour, 
appearance and attitude.

In this feature, we expose all relevant fashion 
workflows, leading to the most prevalent – fashion 
retouching. All roads lead to discovering particular 
Photoshop tools that are applied to create stunning 
visions on screen and in print. But to get there, you’ll 
have to start with the basics.

This feature kicks off by showing you how to 
conceptualise your own design ideas, as you explore 
ways to combine colour, texture and mark making. 
The first half of this feature ends with you finding out 
just how to translate your ideas into digital artwork.

Fashion illustration is still an important style used 
to communicate fashion image ideas. Many believe 
that it has gone from being the sole means of 

communication to having a very minor role, but a lot 
of professional artists still advocate its use; as is 
proved in these pages. Photoshop Brush tools, 
layering techniques and more are discovered. 

Phase two of this feature then tackles the 
demands of a fashion photo shoot. Our experts 
explain exactly what you need to consider to get that 
perfect snap, ready to retouch in Photoshop. Nearly 
every fashion photo is run through the software, with 
retouchers perfecting looks using dedicated tools. 
These include colour adjustments, layer masks, 
brushes and Clone tools. You’ll find out how to use 
them in the pages of this feature. 

However, no matter how altered or retouched a 
fashion photo is, it will always have more association 
with reality and truth than any other format – which 
is why fashion retouching is oh-so popular. Here, 
you’ll discover how to realise a photographer’s 
vision, mood and intention through your own 
improved technical understanding, enhanced by the 
expert advice you will find in the pages of this 
fashion-based article.

SECRETSSECRETS
RETOU CHRETOU CH
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MEET THE 
EXPERTS
DMITRY FOX 
WWW.DMITRYFOX.COM

Fashion 
photographer Dmitry 
Fox likes to shoot to 
the specs, helping to 
minimise the need 
for extensive photo 
retouching later on.

JULIO CESAR GOMEZ 
WWW.JULIOCESARGOMEZ.COM

Julio Cesar Gomez 
combines CG and 
photo elements 
using Photoshop 
techniques to 
produce creative 
fashion retouches.

STEPHANIE WINGER 
WWW.PURETOUCH.FOLIODROP.COM

Retoucher Stephanie 
Winger has her own 
technique hierarchy, 
starting with 
retouching garments, 
then facial features, 
then the rest.

IGNASI MONREAL 
WWW.IGNASIMONREAL.COM

 Freelance illustrator 
Ignasi Monreal 
creates fashion 
illustration wholly 
with Photoshop 
brush styles and 
layering effects.

MONTANA FORBES 
WWW.MONTANAFORBES.COM

Pro fashion 
illustrator Montana 
Forbes finds 
inspiration in a lot of 
things, including 
vintage shops, music 
and cinema.

MARGUERITE SAUVAGE 
WWW.MARGUERITESAUVAGE.COM

Self-made fashion 
illustrator Marguerite 
Sauvage uses 
Photoshop to adjust 
her compositions, 
being able to import 
photos and drawings.

CRISTIAN GIROTTO 
WWW.CRISTIANGIROTTO.COM

Retoucher Cristian 
Girotto finds every 
single tool and 
option in Photoshop 
useful, especially the 
Clone, Dodge and 
Burn tools.

YULIA GORBACHENKO 
WWW.YULIAGORBACHENKO.COM

Fashion and beauty 
photographer Yulia 
Gorbachenko loves 
the way Photoshop 
lets her break the 
rules to create 
dynamic images.

RETOU CH
YULIA GORBACHENKO
www.yuliagorbachenko.com

CRISTIAN GIROTTO
www.cristiangirotto.com

This fashion retouch of 
international model Vanessa 

Cruz was produced by fashion 
and beauty photographer Yulia 

Gorbachenko and high-end 
retoucher Cristian Girotto. 

Gorbachenko admits that your 
choice of model will make or 
break a shoot. “Your model is 

the most important element. Be 
aware that not every fashion 

model can be a beauty model, 
and vice versa,” she explains. 

“The most valuable advice I have 
been given is to work with the 

best possible models.” When it 
comes to retouch, even the 

smallest detail makes a huge 
difference. Girotto explains: 

“Everything is important in a 
picture, even the most remote 
part in the corners. But fabrics 

need to be as perfect as the skin,” 
he reveals. He also explains how 
integral it is to colour correct all 
elements. “Colour adjustments 

help you replicate original colour 
and create new tones,” he adds. 

“I use it a lot to correct colour 
problems that occur after 

dodging and burning.”
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Fashion illustration at its simplest is a device used to 
communicate ideas. Designs form the basis of 
colour, appearance and attitude. Not to be confused 
with figure drawing, fashion illustration prefers a 
stylised look to a realistic one.

It’s about suggestion rather than detail, but before 
pencil can be put to paper, or stylus to tablet, 
illustrators will bring together a collection of 
resources to inspire their designs. Experimenting 
with swatches, textures and pose also helps to keep 
an illustration fresh.

Fashion illustrator Montana Forbes (www.
montanaforbes.com) finds inspiration for such 
things in all walks of life. “I’m mostly inspired by 
walking around the different London boroughs and 
observing how people wear their clothes and the 
variety of dress among the fashion tribes,” she 
reveals. “Also, visiting art galleries and collecting 
vintage clothes and magazines, as well as watching 
classic films and listening to music, is a big help.”

It’s essential to have a passion for fashion and be 
able to reinterpret it from a personal perspective. 
This will help you to translate your ideas digitally, be 
that drawn or photographed and retouched. Though 
instructions provided by a client are important in a 
fashion concept, it is ultimately dependent on the 
illustrator’s focus and creativity in the initial stages of 
conception and idea generation. Here, Forbes 
explains how to make fashion concepts your own.

Plan your  
illustration

DIscovEr wAys To coNcEpTuALIsE, coLour AND 
TExTurE FAsHIoN ILLusTrATIoN IDEAs

Collate swatChes
putting together various mood 
boards helps you to set the tone for 
colours in your design, as well as 
silhouettes and a general style 
aesthetic. This influences and serves 
as a point of reference for your 
personal illustrations. source most of 
the imagery from past and present 
magazines. At times, the boards will 
also include other materials, such as 
fabric samples, leaves, feathers and 
flowers that you can find lying around. 
putting together mood boards is an 
important part of the creative process 
and essential to how fashion 
illustrators work. Not everyone 
transfers swatches into photoshop, 
but with the HuD color picker and 
the ability to save specific swatches in 
the swatches panel, it can’t hurt.
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THE SKETCH PHASE
Once you have a full brief, the first 
thing to do is research poses, 
along with the clothing and 
accessories for the composition. 
Start with loose sketches of a 
couple of ideas until a stronger 
image starts forming. This stage 
is usually done using HB pencils. 
When working on portraits or 
accessories, sometimes a mix of 
pencil, pen and pastels gives you 
a stronger definition of the 
features. Scan your drawings 
directly into Photoshop, then 
clean the composition, getting rid 
of any unwanted marks and 
redefining the drawn lines. Adding 
detail, patterns and colour is 
mostly done digitally.

COLLECT TEXTURES
It’s easy to find a lot of textures 
and other samples from vintage 
and fabric stores around town or 
when travelling. Often, people are 
drawn to pieces that have 
interesting textures; lace being a 
very popular one. Bold designs 
like floral, polka dot and 
houndstooth prints also have a 
visual impact, reinterpreted as a 
drawn pattern or when integrated 
into a digital illustration. Many 
textures tend to look flat once 
they’re digitalised, however, so the 
best ones are those that can be 
scanned directly into Photoshop 
and still keep their detail. 

MIXED MEDIA ELEMENTS
Some projects require a bit of 
experimentation. Where you can, 
have a few mixed media 
elements to use as a whole or as 
part of an illustration. You can use 
photography, pencils, pens, 
charcoal or paints, scans of 
sketches or fabric samples, and 
of course, digitally produced 
imagery. Mixed media sources 
vary between each artist. You 
could even use your old 
photographs or ones from vintage 
magazines. The application of 
mixed media can enhance or 
bring an illustration to life, with 
multiple elements working 
together to create one eye-
catching visual concept. 

I’m mostly inspired by 
walking around the 

different London boroughs 
and observing the variety of dress 
among the fashion tribes
MONTANA FORBES / WWW.MONTANAFORBES.COM



Photoshop becomes 
useful for everything, from    

adjusting a composition to 
repeating a pattern, even importing 
elements from a photo or drawing
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Many believe that fashion illustration has gone from being the sole 
means of communication to having a very minor role. But a lot of 
professional artists are still advocating its use. Contemporary styles are 
being used to promote both merchandise and commercial brands.

Operating in a fast-paced advertising industry has been made 
possible due to a digital workflow. Photoshop’s Undo functionality has 
been a game changer, with additional tools and options accelerating 
work development even further. “Cut and paste are the brothers of 
Undo,” adds self-made illustrator Marguerite Sauvage (www.
margueritesauvage.com). “These embody how digital programs can 
be far more flexible. Photoshop becomes useful for everything, from 
adjusting a composition to repeating a pattern, even importing 
elements from a photo or from another drawing.”

However, fashion illustrators still try to maintain a traditional look, 
whether that’s painterly or mixed media-based. “Using too many filters, 
pattern overlays or gradients will make your images look overly 
digitised, monotonous, even unprofessional,” warns Sauvage. “You’ll still 
have to include these tools in your own creative recipe, but make their 
use part of a wider personal process.” 

Sauvage ensures this by making drawing the most important part of 
her image-making process. Her images are drawn by hand, using a 2B 
3mm pencil, only then scanned in at 450 or 300dpi. “They can either be 
inked by hand or on the computer,” she says. Once scanned, her images 
are exported into Photoshop for colouring and texturing, using 
personalised Photoshop brushes, patterns and scanned textures. “I 
create my own brushes by playing with Pressure, Opacity and Diffusion 
settings,” she reveals. 

This is something that freelance illustrator Ignasi Monreal (www.
ignasimonreal.com) also does particularly well, instead mastering 
Photoshop’s brush presets for his entire creative process. “I can create 
varying effects using different types, playing with Opacity and Flow for 
even more versatility,” he explains. “I try to create a traditional painted 
look by working with thick strokes and different textures.”

Texture application is important to both our digital illustrators, with 
Monreal believing that a good example will always make a fashion 
illustration more vibrant and interesting. “Using digital textures also 
allows me to implement fabric and metal surfaces that would be 
almost impossible if I used traditional tools,” he explains.

Fashion your sketches  
inside PhotoshoP

MaSTer BrUSH MODeS anD PreSeTS TO 
PrODUCe IllUSTraTIve STYleS

MargueriTe sauvage / www.margueritesauvage.com

layer it up
I place my black-and-white lined layer on top of my image, set to Multiply 
blending mode, then start painting to new layers underneath.
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001 | Sketching
To begin with, sketch the layout of your 
illustration using a basic Photoshop 
brush. Set both Opacity and Fill to 
Pressure and use a grey colour. It’s very 
important to pay close attention to detail 
in this sketch phase.

003 | Gradients and textures
Adding gradients and textures can be 
used to add interesting ambience to your 
fashion illustration. Playing with Opacity 
and the layer blending modes, such as 
Multiply and Overlay, will achieve very 
interesting and unexpected results.

002 | Painting
Start painting every element in the 
picture on different layers. This allows 
you to change each one separately. You’re 
now able to apply any effect to a specific 
part of the illustration whenever you 
want to, instead of doing it all over again.

004 | High Pass sharpening
Boost your brush strokes to make sure 
the illustration has a painterly effect. 
Sharpen these by duplicating the final 
image layer, set it to Soft Light and add 
Filter>Other>High Pass at 2 pixels. The 
more pixels you add, the more contrast 
between darks and light you’ll achieve.

Illustrate 
fashIon 
usIng 
PhotoshoP 
tools 
See HOw MOnreAL APPLIeS 
BruSH TOOLS And FILTerS TO 
creATe excITIng FASHIOn 
ILLuSTrATIOn

001

004

002

003
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What to consider 
on a fashion shoot 
Fashion photographer Dmitry Fox shares his 
proFessional secrets For taking great shots

techniques    pro retouch secrets

If there’s been a decline in fashion illustration, then it 
is mainly due to fashion photography. This is popular 
with clients seeking images for editorial and 
advertising. No matter how altered or retouched a 
photo is, it will always have more association with 
reality and by association truth, therefore promoting 
a product more successfully. 

However, this all relies on taking a solid snap to 
begin with, which must ultimately capture a moment 
that engages your viewer. There are many ways to 
do this, dependent on many factors. Using props, 

maintaining eye contact, creating a sense of mystery 
with a model looking away, and experimenting with 
light, movement and angle are all relevant. 

The final context of your photo is also important, 
as photographer Dmitry Fox (http://dmitryfox.com) 
explains: “If your image is for an advertising 
campaign, the main task is to draw interest to the 
subject – whether that’s clothing, accessories or 
something else. As for fashion shoots, there are no 
rules. Sometimes you just take crazy clothes into the 
studio and experiment until you get the perfect shot.”

Fox finds inspiration all around for his shoots, but 
specifically through cinematic reference. He’ll often 
try to create cool backlighting and other elements in 
his projects. Trying to capture such effects in the 
shoot phase minimises retouch times. “Set the 
studio lights, trying different variations of aperture, 
view the results on a laptop and if all is well start 
shooting,” he explains. “If you don’t approach camera 
effects seriously then your edits in the post phase 
will take much longer.” Here, he offers more advice 
on taking that perfect fashion shot.

PrePare your shoot
GeT pHoTo ASSeTS rIGHT THe FIrST 
TIme wITH THIS experT ADvIce

the right model
 Last year, I had an important shoot. The team were well 
prepared, but as I started to photograph, the results 
seemed terrible. we persevered for about half an hour, 
then my make-up artist offered up another model and 
everything fell into place. This shows how important it is 
to choose the right model for a project.

each shoot has its own model requirements, but one 
thing remains constant – a model must evoke the right 
emotions in the photo. of course, professional models are 
more flexible as they can improvise and present several 
poses, saving the situation. If you’re working with 
beginner models, it’s best to take some test shots first.

dmitry fox 
www.dmitryfox.com
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THE RIGHT LOCATION
Creating an atmosphere that complements your 
shoot is one of the most difficult tasks for a 
photographer. This is all dependent on your choice of 
location, and even the slightest mismatch can spoil a 
project. Establishing the theme you want first, 
including elements like the interior design, landscape 
and natural lighting, will help narrow down the list of 
locations suitable for your project. Sometimes, if you 
need maximum light control and the involvement of 
a large number of light sources, it is easier to 
recreate the desired setting in a decorated studio. 
However, it may be the case that it’s impossible to 
achieve exactly what you want from your shoot 
unless it is carried out on location.

THE RIGHT THEME
If you need to come up with a theme for your shoot, there are many different 
sources that can help you. You could review your favourite movies or music albums, 
or even just walk out onto the street. Wherever you are, you’re sure to find 
inspiration. Just make certain that you stick to your vision. 

Finding the right theme is sometimes a subconscious effort. Ideas can come to 
you from nowhere, but you should always think them through, considering how 
easy they will be to implement and how likely they are to produce. Sadly, it’s often 
the most complex and complicated themes that you’ll want to try and show through 
your lens. Some of us work with a team of hair stylists, make-up artists, and 
stylists, who can all offer great input to help you. But be sure to take control of your 
own project’s story so it translates how you want it to.
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ESSENTIAL KIT FOR FASHION PHOTOGRAPHERS
DMITRY FOX EXPLAINS HIS MUST-HAVE DEVICES THAT LET HIM SHOOT GREAT FASHION IMAGES

CANON 5D MARK 3
The 5D Mark III is a firm choice due 
to its ergonomics and decent 
picture quality. This camera is very 
comfortable to use, and a smooth 
transition between the photo and 
the video modes allows you to 
easily capture interesting moments 
on a shoot.

CANON EF 100MM 2.8L 
MACRO
This lens provides awesome 
contrast and sharp detail. It’s great 
for shooting portraits as well as 
accessories. When shooting with 
open aperture, the lens gives you a 
beautiful bokeh effect and very 
gently blurs the background.

CANON EF 50MM 1.4
The EF 50mm is a simple and 
inexpensive lens that provides 
excellent picture quality. Its focal 
length is suitable for shooting big 
scenes at any location, and it’s also 
suitable for close-up portraits, 
especially if you like photos with 
some perspective distortion. 

MONOPOD MANFROTTO 
681B
Once you decide to use a monopod 
to shoot, you’ll wonder how you 
ever lived without it. Having a point 
of support means you can choose 
the exact angle you want every 
time. It’s a very convenient piece of 
kit for fashion photographers.



001 | Skin retouch
I use frequency separation techniques to 
clean skin, then define image textures 
using a Brightness/Contrast adjustment 
layer. Next, I apply a Dodge & Burn layer 
to enhance contour and image lighting.

003 | Colour work
This is an important stage, as I use Black 
& White adjustment layers to re-colour 
each element. The ultimate goal is to 
create tonality that brings photo and 3D 
elements together in one believable look. 
I add some light and shadows with a 
Multiply or Screen blending mode.

002 | Comping 3D elements
Here, I’ve composited both the 3D and 
photo elements together, taking special 
care with my masking processes so as to 
create believable edges. Ideally you will 
want all proportions to feel natural, then 
work more carefully into areas where the 
two elements meet.

004 | Add light and colour
Add a Black & White photo layer with 
visible exposure and set its blending 
mode to Screen to simulate reflective 
glass. Tweak effects by editing layer 
masks and painting in new light sources 
to a new Soft Light blending mode layer.
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Nearly every fashion photo is run through 
Photoshop, with retouchers perfecting looks using 
dedicated tool sets. Many effects build upon beauty 
retouch techniques. Correcting the model is equally 
as important as editing clothing, but not always in 
that order. It seems as though each retoucher has 
their own hierarchy of effects.

High-end fashion and beauty retoucher Stephanie 
Winger (http://puretouch.foliodrop.com) tackles 
clothing before moving onto a model’s features. She 
reveals: “Clothes have to first fit perfectly and look 
flawless, then my attention turns to the model. All 
distracting details are cleaned up.”

The Clone Stamp tool and Spot Healing brush are 
perfect tools for redefining smaller areas of an 
image. Professional retouchers will set these tools to 
a soft style, with Airbrush and Pressure for Opacity 
activated to avoid hard transitions. “If I have to clean 
up larger parts of an image, I copy and paste entire 
sections, mask them out, then paint them back in 
using a soft brush,” Winger adds. “This gives me 
more control over realistic results.”

It’s good practice to also zoom in and out of your 
image every few minutes. Distances should range 
from close up (33%) to full scale (100%) and 
somewhere in between (75%). This certainly helps 
when smoothing garments, which can be done using 
Photoshop frequency separation techniques. 

Frequency separation is achieved by retouchers 
duplicating their original layer twice, then naming the 
copy layer at the top of their stack ‘High Frequency’ 
and the copy layer beneath this ‘Low Frequency’. The 
Low Frequency layer is activated and Gaussian Blur 
added, then the High Frequency layer is activated and 

post-production retouch
Our ArTISTS SHAre PHOTOSHOP TeCHNIqueS FOr 
eDITING HIGH-eND FASHION PHOTOS

Image>Apply Image is added. Layer is set to Low 
Frequency, Blending to Subtract, Scale to 2 and 
Offset 120. Now both can be edited with a soft Clone 
Stamp tool and layer masks to create smoothing 
effects, as well as improve overall light detail.

Only after a fashion photo has been cleaned can a 
retoucher turn their attention to accentuating style 
and mood, which is normally done through editing 
colour and light. Curves, Layers and Hue/Saturation 
colour adjustments are normally applied to a Smart 
Object layer for non-destructive edits. “each 
adjustment layer works differently,” advises Winger. 
“For example, applying a Black & White adjustment 
layer set to Multiply mode, then editing Opacity, gives 
you the opportunity to add a moody look.” 

Individual Curves channels can also be added to 
readjust colour brightness, with Hue/Saturation 
applied to swap colours, using layer masks to paint 
to specific garments. Colour tweaks can also be used 
to edit image temperature, and thus dictate mood. 
However, many retouchers will urge you to stick with 
realistic results due to the fact that you’ll be 
presenting real-world products, no matter how 
inspirational your designs are. ©
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© Lukasz Breskiewicz

This is a great example of how, if you get 
your shoot right, a clean retouch is all you 
need – no filters or adjustments necessary

Add a Black & 
White adjustment 
layer and set its 
blending mode to 
Soft Light. Set a 
low opacity and 
change each colour 
slider to make 
individual changes 
to colour
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Credits: Wardrobe & shoes: Ana Ljubinković, Photo:  Miloš Nadaždin, 
Model: Zorana Obradović, Hair: Olivera Milićević, Make-up: Marko Nikolić
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SET UP COMPOSITION
MAKE A SELECTION OF PHOTOS AND SET UP YOUR FORMAT

02  SELECT THE MODEL
First, select a model of your choice from 

any photo stock site. Open the Channels panel and 
select Blue. Ctrl/right-click then duplicate this. Go to 
Image>Adjustment>Levels and make a small 
adjustment to increase contrast. The main goal is to 
keep edges of the hair and not cut them off. Go to 
Image>Apply Image, choose Blending: Overlay.

03  PAINT TO YOUR CHANNEL
Paint the model with a black brush and the 

background with a white one, using different sizes of 
hard brush. Keep edges as they were in the original 
image. Cmd/Ctrl-click on the duplicate thumbnail 
and create a selection of all black areas. Turn on the 
visibility of the RGB channels and open the Layers 
window. Drag the model into your working file.

CHANGING A PHOTO INTO A 
FASHION ILLUSTRATION

WORK IN 
PROGRESS

Progress 1: Basic environment

Progress 2: Other elements

Progress 3: Layer adjustments

FOLLOW PHOTOSHOP METHODS AND TECHNIQUES FOR 
DESIGNING FASHION�BASED ILLUSTRATION

PRO RETOUCH FEATURE TUTORIAL

EXPERT
COMPOSITING

Fashion illustration can take many forms. You 
can easily take regular photos and use these 
to add in your own design. Digital artists can 
use brushes, textures, scanned handmade 

drawings and royalty free stock to invent vibrant 
images. The techniques used in this tutorial can be 
applied in nearly all versions of Photoshop, which 
gives you plenty of possibilities for fast editing as 
you adjust colour and light. Most of the work is 
done with layers, colour adjustments, blending 
modes, selections, painting and layer styles.

You’ll also need a pen tablet and scanner if you’re 
planning on building your own image. If not, then it 
is advisable to prepare drawings, however there are 
some additional images available for the objects 
along with other stock images. Nature and floral 
elements were the main inspiration for this 
illustration. The goal is to achieve a romantic, 
feminine mood where the beauty of the model is 
highlighted. Prepared material, as well as the steps 
below, will leave you with enough skills to revisit 
and adapt the image to your own liking. 

EXPERT COMPOSITING   TECHNIQUES    

VESNA PEŠIĆ BECHA
www.becha.me

OUR EXPERT

Becha is a freelance illustrator based 
in Novi Sad, Serbia. Her technique is 
mostly digital collage. She’s worked 
with ELLE, Playboy, Universal Music, 
Emirates, Yamaha and many more 
international clients.

SOURCE FILES
Files supplied on the disc can be 
used to speed up your process. Edit 
these to suit your own style. Please 
note: files supplied are only to be 
used in relation to this tutorial.

01  CREATE YOUR 
WORKSPACE

Create a new file 235mm wide by 
302mm high at 300dpi. The 
background will be made using a 
gradient. Activate the Gradient tool 
and in the Gradient Editor choose a 
#e2ebdb colour in one Color Stop 
and #69adbf in the other. Then drag 
the Gradient tool line from the 
bottom edge to the upper edge.
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08  ANIMAL COLLAGE 
Open the ‘Fawn.psd’, ‘Yellow Rose.psd’ and 

‘Horns.psd’ from the disc. Select and drag them into 
your working image. Activate the Fawn layer and 
apply Color Balance, setting values to +48, -22 and 
-36. Activate the Horns layer and again add Color 
Balance, setting values to +66, -63 and -34. Create a 
new layer beneath your Yellow Rose layer and apply 
a #977166 colour to create a shadow. Do this by 
applying a soft brush with the Always Use Pressure 
For Opacity option active.

06  ADD FLOWERS 
Go to CG Textures and download the 24670 

flowerbed file. Use the Pen tool to make a selection 
of your flowers, then drag them into your image. 
Since two flowers bushes are needed, duplicate your 
new layer and reposition the duplicate using the 
Transform tool. Now apply colour corrections. Select 
Image>Adjustment>Levels and input the following 
values: 0, 2.00 and 220. Then apply a Hue/Saturation 
layer, setting Saturation at -50. Finally, apply a Color 
Balance adjustment layer at +8 , -31 and -28.

04  TRANSFORM ELEMENTS
Go to cgtextures.com, then search and download the large sized 12107 grass file. Drag this into 

your working file. Press Cmd/Ctrl+T, then Ctrl/right-click a control point and choose Perspective from the 
pop-up options. Narrow the upper control points then, without pressing enter, Ctrl/right-click again and 
choose Distort. Click the upper-middle point and lower it. After this, choose Warp and adjust like in the 
example presented, using points to create Bézier curves. Your goal is to make a curved surface.

07  DECORATIVE THORNS
Create thorns by adding the Pen Path tool 

to a new layer. Select a 30px hard white brush and in 
the Paths panel, Ctrl/right-click your path thumbnail. 
Select Stroke with Simulate Pressure deactivated. 
Choose Select>Load Selection and use a soft brush 
at 15px, with Always Use Pressure For Opacity 
activated from the Brush options. Add shadows to 
the edges of your line, using a #b7b7b7 coloured 
brush on a new layer. Open ‘Thorns.psd’ and paste 
them in, arranging them on the stem you’ve created.

    QUICK TIP 
Shade objects in your images more easily by 
working to a new layer. Always place this 
directly above the one you want to edit. For 
better results, always lay your shadow marks 
with a Multiply blending mode. Also, before you 
start painting, load a selection of the layer 
below, then press Cmd/Ctrl+H to hide it.

TECHNIQUES    EXPERT COMPOSITING

05  ADD PEARLS
Open ‘Pearl.psd’ and drag the layer into 

your image. Cmd/Ctrl+J to make a few duplicate 
layers of this. Use Transform to resize your layers 
and arrange on top of the grass layer, making sure 
that the bigger ones are closer and smaller ones 
further away. Use the Polygonal Lasso tool to select 
grass shapes and duplicate these from the grass 
texture layer. Place these new cut-out layers above 
your pearl ones. Add Layer>Layer Style>Inner 
Shadow to the biggest pearl layer, setting Opacity at 
75%, Angle at -75 degrees, Distance at 20, Choke at 
0 and Size at 109.
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Add shadows to the edges of your line using a #b7b7b7 
coloured brush on a new layer

11  HORNS
Creating the horns is a similar process to 

the mask. First, draw these out using the Pen tool. 
Then make a selection of the horns and fill this with 
white in a new layer. Add a Bevel & Emboss Layer 
Style and set Style to Inner Bevel, Technique to 
Smooth, Depth at 276%, Size at 13, Soften at 13, 
Shadow Mode to Multiply, Color to #77979e and 
Opacity at 38%. Everything else is set to default. 
Open the ‘Flowers.psd’ supplied on disc and drag this 
into your working image. Place and transform to 
build the best look. 

10  CREATE A MASK
Use the Pen tool to draw a path that follows 

the contour of the face with horned extensions. 
When closed, make a selection of it, add a new layer 
and fill it with white. Apply shadows to edges to 
create a 3D effect using a #b7b7b7 coloured soft 
brush, with the Always Use Pressure For Opacity 
option activated. Before you start painting shadow, 
you need to load a selection of the mask, then make 
a new layer above. Paint to this with a soft brush, 
creating shadow. Apply Gaussian Blur at a 4px 
radius, while your mask selection is still active. 

13  TREES
Trunks can be made with a #c9c9c9 coloured hard brush. A #767676 coloured soft brush is added to 

create shadow in the middle of the trunk. Change your brush group to Dry Media. Pick a Soft Oil Pastel brush 
with a #767676 colour and add lines of varying sizes to the trunk. Download the 55089 trees image from CG 
Textures and select only the treetop, dragging it into your image. Apply Levels set to 0, 1.88 and 245. Now add 
Hue/Saturation, setting Saturation at -25. Finally, add Color balance, setting values at 100, 0, +100. 

09  CREATE ARROWS 
Make the body of your arrows by applying a 

selection with your Rectangular Marquee tool and 
filling this with a #404040 colour. Add an Inner Glow 
Layer Style and set Blend Mode to Screen, Color to 
#c3a87c, Technique to Softer, Source to Center, Size 
at 29 and Choke to 18. Use the Pen Shape tool to 
create arrowheads, adding a #3f3f3f to #5e5341 
colour gradient overlay. For the fletchings, download 
the 107167 branches file from CG Textures and 
change it to red using colour adjustments. Merge the 
layers and duplicate, then place in the model’s hands.

12  WHITE PARTS
Now you will continue to add what looks 

like bits of porcelain to the model’s skin. First, make 
use of the Pen tool to make a selection as before, 
then press Cmd/Ctrl+J to duplicate a skin section. 
With this duplicated layer selected, go to Image>
Adjustment>Desaturate. Load a selection of this 
shape and apply Gaussian Blur set at a 10px radius. 
Deselect (Cmd/Ctrl+D) your selection, duplicate this 
layer twice, then merge all three layers. Go to Levels 
and input the following values: 15, 1.18 and 228. 
Apply shadow below the objects using a #926958 
coloured brush applied to a new layer set to a 
Multiply blending mode.

SET UP DETAIL
ADD MORE ELEMENTS TO THE COMPOSITION

EXPERT COMPOSITING   TECHNIQUES 



SET THE MOOD
ADD ELEMENTS AND EFFECTS THAT WILL ENRICH COMPOSITION 

14  GLOWING EFFECTS
Open the ‘Bird.psd’ file from the disc and 

drag it into your working image. Create a glow effect 
behind your model using the Elliptical Marquee tool. 
Before making your selection, set Feather at 200px. 
Apply to your background layer and press Cmd/
Ctrl+J to duplicate. Add Levels, setting values at 0, 
2.08 and 255. Add Color Balance, setting values to 0, 
0 and 100. Duplicate your pearls and arrange them at 
different sizes, floating at the top of the image. 

15  IMPROVE THE MOOD 
To improve mood and connect the elements 

together, apply textures and adjustment layers. Open 
‘Texture.jpg’ supplied on the disc and drag it into your 
working image. This layer needs to be above all 
other layers. Set its blending mode to Soft Light. Add 
more contrast using Layers>New Adjustment 
Layer>Curves. Select the Green curves channel and 
add a slight upwards curve to affect the image 
colour. See the position in the screenshot below.

16  SETTINGS
 After changing the overall colour and 

mood, it’s time to polish your image and review all 
image elements. To make the model’s hair brighter, 
use the Dodge tool with Exposure set at 70% and 
pass over this area and darker parts of the dress. To 
make the model closer to her environment, apply 
Levels with input set to 0, 1.18 and 255. The grass 
also looks too dark, so apply Levels with input 
values set to 0, 1.35, 241. Set output to 11 and 231.

17  SHADOWS
Adding shadow defines your main light 

source much better. The most important shadows 
exist in the grass layer. Choose a #979842 colour and 
create a new layer. Select a soft brush set to Always 
Use Pressure For Opacity and paint in shadows 
beneath the model, pearls and trees with varying 
brush sizes. The model’s shoes also need to be 
darker, so use the Eyedropper tool to choose a 
darker tone from these. With the same brush 
settings, make the lower part of the shoes darker.

18  SUN RAYS
These illustrated sunrays are made in 

Adobe Illustrator. In a new file, make one straight line 
with a 1pt stroke. Select Effect>Distort and 
Transform>Transform. Change Scale/Vertical to 
109%, make 40 copies and set Angle at 124°. Turn 
colour to white and drag objects into your image. 
Resize this new vector layer then Rasterize it (Cmd/
Ctrl-click layer> Rasterize layer). To avoid sharp ends 
in your lines, apply a soft brush Erase tool and erase 
the tops of these with one click. 

     QUICK TIP
Take care of light and it will take care of the rest, 
making your image much more convincing. All 
newly imported images and elements need to be 
edited so that they follow one light source.

     IMPROVING GENERAL ATMOSPHERE 
Applying textures and layer adjustments is 
important, as these tighten up the image and 
make all elements look as if they belong in the 
same space. Very often an image looks too raw. 
Vignette effects in particular focus all elements in 
a single space, making the whole image less flat. 
Layer adjustments can work to create some 
exciting effects, but first and foremost their main 
concern is with creating colour harmony, existing 
throughout all your layers.
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Not only does the 
AMD FirePro system 

create a capable 
environment, it increases 
performance in ways 
previous systems could 
only dream about
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THE COMBINATION OF AMD FIREPRO AND ADOBE CREATIVE CLOUD PROVIDE 
DIGITAL CONTENT CREATORS WITH THEIR MOST POWERFUL TOOLSET EVER

D igital artists in today’s marketplace 
frequently find themselves lost in a labyrinth 
of various software and hardware 
combination options. Most artists 

understand the software they want to use, but don’t 
have as firm a grasp on the type of hardware they 
should opt for to best support their preferred 
applications. Researching the matter frequently 
leads to frustration, as every manufacturer claims 
their product is the fastest, most efficient and most 
optimised kit available.

There’s also the challenge of figuring out the best 
approach for a system using limited funds. Should 
processor speed be sacrificed to purchase a better 
graphics card? How much RAM is enough? What 
about the core operating system? For a creative 
individual who just wants to be able to craft great art 
in Adobe Photoshop, or the video professional who 
needs a better system to handle their editing 
demands in Adobe Premiere Pro, these questions 
can feel overwhelming.

However, there is relief for the artist who doesn’t 
care what a bit does and just wants their tools to 
work! The software available in Adobe Creative 
Cloud coupled with AMD hardware promises to 
provide a tight integration between software and 
hardware, specifically between Adobe Photoshop 
and Adobe Premiere Pro and AMD’s FirePro 
workstation-class graphics cards. It’s a collaboration 
that enables creatives to create their best work yet, 
with products optimised for speed and performance. 

The immediate benefit for the user is that this 
takes much of the guesswork out of the hardware 
choice. When choosing a graphics card, you want the 

one that is optimised for the tools you use every day. 
With the Adobe and AMD collaboration, you can reap 
the benefit of using a system that’s vastly more 
capable of handling the demands of your projects. 

Finally the terms ‘real-time’ and ‘video effects’ 
can go hand in hand. Not only does the AMD FirePro 
system create a capable environment, it increases 
performance in ways previous systems could only 
dream of. 

  THE OPENCL REVOLUTION
WHY OPENCL IS THE SUPERIOR CHOICE

One of AMD’s strategies for achieving increased 
performance is known as Open Computer 
Language, more commonly referred to as OpenCL.

To understand OpenCL, you first need to 
understand a bit about processors. Generally, a 
system has two distinct types of processors: a CPU 
that’s comprised of the main processing core of 
the machine and a GPU, or Graphics Processing 
Unit. Think of these as two engines attached to a 
single vehicle. 

Previous computing strategies have seen the 
CPU handle the majority of the computing tasks 
while certain graphics-intensive tasks were handed 
off to the GPU. For the most part, this approach 
treats the GPU like a spare engine, only called upon 
during very specific jobs to assist the primary. 

The problem with this approach is that much of 
the time this extra horsepower is left locked away 
from the primary machine, unused except in 
predetermined instances. In our engine metaphor, it 
would be akin to turning off the secondary engine 
except when driving up specific hills that were 
already marked on your map. If you happened to 
encounter a hill or rough road not on your map, or 
simply needed some extra speed, that secondary 
engine sits completely idle and is of no use. 

With OpenCL, however, the GPU is available for 
moments not predetermined by the architecture. 
This means the additional processing power of that 
GPU is unlocked and can be used for tasks the 
primary CPU might be overwhelmed with or less 
suited for*. 

ADVERTORIAL    AMD    

UNLEASH
CREATIVITY

YOUR

SPEED, PERFORMANCE AND EFFICIENCY
A FACT�BASED LOOK AT WHAT AMD FIREPRO BRINGS TO YOUR WORKSTATION
Benchmark tests show that an AMD FirePro W5000 card using OpenCL architecture performs up to 
eight times faster than using so� ware alone while rendering video to disk**. Similar tests show the 
OpenCL performance as 40 per cent faster than NVIDIA’s CUDA, and the FirePro GCN proved to be 
up to 28 per cent more effi  cient than the NVIDIA Quadro.
** So� ware: Adobe Premiere Pro pre-release build 294 / Windows 7 64-bit, Eff ects: ProcAmp, Sharpen, Color Balance (RGB), RGB 
Color Corrector, Lumetri (multiple Deep Color eff ects)

System: Intel Xeon E5530 @ 2.40 GHZ, 12GB memory, 160GB Velociraptor, Drivers: AMD 12.102 / NVIDIA 311.35, Content: 4K TIFF 
24-bit sequence

ADVERTORIAL

*To learn more head to http://blogs.adobe.com/standards/2013/05/03/opencl-enables-more-compelling-and-efficient-applications/
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So what does this mean for you? Quite simply, it 
means better performance for more tasks. To point 
to just a couple of direct instances, Photoshop CC’s 
new Sharpen and Blur filters make extensive use of 
OpenCL architecture and are much faster and more 
responsive than ever before. Likewise with Adobe 
Premiere, the Mercury Playback Engine allows you 
to experience the AMD FirePro using OpenCL and a 
multi-core CPU. You can edit full-resolution video 
seamlessly, without hesitation, and apply video 
effects in real-time without needing to wait for a 
preview render.

  A FEAST FOR THE EYES
WHY YOU SHOULD CARE ABOUT 10-BIT VISUALS

Traditional systems have dealt with colour by using 
the familiar three channels: red, green and blue. 
These systems create pixel information with eight 
bits in each, hence the 24-bit displays. While this 
creates more than 16 million colours, it’s truly just a 
fraction of the total colour spectrum our eyes see in 
real life. AMD’s FirePro cards support ten bits per 
colour channel, which enables a 30-bit colour output 
and billions of colours. This increased colour depth is 
particularly important to professional photographers 
and those using medical imagery. With 10-bit colour 
your creative experience will be revolutionised in 
ways you could never imagine. All AMD FirePro 
cards support 10-bit, and a monitor that also 
supports 10-bit colour will be required.

  MAKING IT WORK
GETTING THE MOST OUT OF THE AMD FIREPRO

Few things can be more frustrating than researching, 
purchasing, installing and attempting to use a new 

piece of equipment, just to find that it doesn’t work 
as expected. After all the promised gains in speed 
and performance, nothing feels even slightly 
different. You’ve updated the drivers, checked the 
connections, rebooted several times, yet still nothing. 
What happened? Chances are that you missed a 
critical step in the process: the setup. You’ll never be 
able to take advantage of this new technology unless 
you tell your software how to do so.

In Photoshop CC, this control is in the 
Preferences menu (Edit>Preferences>Performance). 
Look to the lower-right in the Graphics Processor 
Settings and verify the system is reading your 
graphics card correctly. Check the box for Use 
Graphics Processor and then hit the Advanced 
Settings button. In this box, set the Drawing Mode to 
Advanced, check the boxes for Use Graphics 
Processor to Accelerate Computation and then 
check Use OpenCL. If you have a 30-bit display, 
check the relevant box to activate it to get the most 
use out of your graphics card. Once these settings 
have been selected, it’s time to test the merits of 
your setup. One of the best ways to test it in 
Photoshop is to open up a large file and run an 
intensive operation, such as Puppet Warp, Liquify, 
the Blur Gallery filters or the new Smart Sharpen. 
You should see a significant increase in 
performance with these tasks and many others. 

When starting a new project in Adobe Premiere 
Pro CC, access the drop-down box under Video 
Rendering and Playback. Change the setting from 
Mercury Playback Engine Software Only, to Mercury 
Playback Engine GPU Acceleration. These same 
settings can be accessed later, simply by navigating 
to File>Project Settings>General.

Working in 3D and 2.5D 
is now as smooth and 

responsive as 2D, which 
enables more creative 
freedom as artists can spend 
more time crafting their art, 
not waiting for renders

HARDER, BETTER, 
FASTER, STRONGER
WHY UTILISING THE GPU IS A 
BETTER CHOICE THAN SIMPLY 
USING A MULTI�THREADED CPU
One of the great challenges of computing is 
that there are several tasks that need to be 
calculated simultaneously. A traditional 
approach to solving this is to use a multi-
threaded CPU architecture to handle the 
multiple tasks; an approach certainly better 
than the juggling act performed previously by 
single-threaded CPUs. However, with a GPU 
on board, the graphics card processors are 
designed to handle multiple parallel 
processing for compute functions. Now the 
OpenCL architecture makes these 
powerhouse processors available for more 
than just dedicated graphics tasks. They may 
now assist the CPU with other heavy li� ing 
too. Ultimately this makes the entire system 
faster and stronger, which means you can 
work with speed and confi dence on even the 
most demanding of tasks.

With the help of OpenCL, 
GPUs are made available 
whenever parallel processing 
is most beneficial or desired 
for the task at hand

By using OpenCL architecture, 
FirePro graphics cards are able 
to render video to disk 26 
times faster than 
software alone

After Effects and CC benefit greatly 
from OpenGL capability
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  OPENGL DESIGN
WHAT OPENGL MEANS FOR THE PHOTOSHOP AND 
AFTER EFFECTS USER

OpenGL, or Open Graphics Library (not to be 
confused with OpenCL mentioned earlier) is a set of 
standards for high-performance processing that 
carries intensive graphics operations to the GPU for 
better handling. Frequently, these operations involve 
the use of 3D graphics and other processor-intensive 
functions. The proper use of OpenGL requires a 
graphics card with the horsepower to handle these 
demanding tasks. AMD’s FirePro cards fit this 
demand nicely. AMD has been working with Adobe 
to ensure that the card and software work together 
to provide an OpenGL-accelerated workflow, as well 
as a far faster and more efficient graphics pipeline.

By using the AMD FirePro cards’ OpenGL 
capability, Photoshop and CC see substantial 
performance gains in accelerated features such as 
the Adaptive Wide Angle filter, Field Blur, Iris Blur, 
Tilt/Shift and the revamped Lighting Effects Gallery. 
Former processor-intensive features such as the 
Liquify filter are now smooth, responsive and fluid. 
There are also other features that are only available 

through the use of OpenGL processing, like the 
Rotate Canvas tool, Scrubby Zoom, Flick Panning, or 
the Bristle brush tip preview. These features are 
more than window dressing, however, and provide 
substantial interface improvements that save time, 
enhance artistic focus and contribute to a more 
efficient production pipeline.

In After Effects, the use of OpenGL and GPU is a 
significant contributor to your workflow. New 
features in CC, like the new Live 3D Pipeline that can 
import CINEMA 4D scenes as layers, will change the 
way video professionals approach their projects. 
Working in 3D and 2.5D is now as smooth and 
responsive as 2D, which enables more creative 
freedom as artists can spend more time crafting 
their art, not waiting for renders. 

After Effects CC leverages the new processor 
gains to provide features that would previously have 
been too intensive to be workable. Features include 
the new 3D Camera Tracker, Pixel Motion Blur and a 
retooled Warp Stabilizer VFX. Overall, After Effects CC 
uses several methods of optimisation and 
acceleration, enabling users to create more in far 
less time.

STABILITY AND POISE
DISCOVER A FEW STRATEGIES FOR 
CREATING A BALANCED SYSTEM
The best approach for reliable, high-
performance, graphical computing is to 
create a balanced system. A powerhouse 
graphics card won’t do much good if there 
isn’t a solid system to support it, a� er all. This 
approach entails several elements working 
in tandem. The CPU must be adequate to 
support the rigorous demands of the job, so 
you will want to use a quad-core processor 
such as the AMD Phenom II. The operating 
system needs to be a 64-bit OS like Windows 
7 or 8. The system should have more than 
8GB of RAM, multiple disk drives (preferably 
in a RAID 0 confi guration) and at least 15GB of 
available empty disk space for temporary 
working fi les. Of course, you’ll also need a 
powerful AMD FirePro graphics card.

A NEW VISION
A GLIMPSE AT AMD EYEFINITY 
MULTI�DISPLAY TECHNOLOGY
AMD Eyefi nity multi-display technology 
enables an AMD FirePro graphics card to 
drive three, four or even six monitors via 
DisplayPort 1.2 from a single graphics card, 
at up to 4,000 x 2,000 resolution for each 
output. You can speed up your workfl ow by 
using your extra screens to view additional 
Audio Mixer or Metadata panels; run A� er 
Eff ects and Photoshop sessions 
simultaneously; or simply refer to your 
storyboards and project brief. Even 
something as simple as being able to monitor 
your email on a dedicated screen without 
ever having to minimise your project can 
yield a signifi cantly more effi  cient workfl ow.

FOR ON�THE�GO ARTISTS
HERE’S A RUNDOWN OF THE TOP 
TIME�SAVING FEATURES ENABLED 
BY AMD’S FIREPRO
• Apply even the most intensive eff ects to 
video projects and see the results in 
real-time without having to generate a 
preview render.
 • Work on full-resolution video fi les in 
Premiere Pro and scrub through the timeline 
seamlessly without stuttering or hesitation.
• Use the heaviest fi lters in Photoshop CC on 
even high-resolution images without having 
to wait for the system to catch up. Operations 
like Liquify and Puppet Warp are silky 
smooth and responsive.
• Direct import of CINEMA 4D fi les as layers 
into A� er Eff ects CC means less juggling of 
fi le formats and more creative editing.
• Multiple screens enable a larger desktop 
and more applications to be visible at the 
same time, reducing the minimise/maximise 
dance of windows.

Smart Sharpen in Photoshop gets a 
boost thanks to the GPU benefits

With AMD 
Eyefinity, users 
can move from 
uploading, to 
editing, to post 
work seamlessly

CINEWARE is 
the innovation 

that brings 
After Effects 
and CINEMA 
4D together
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It’s wise to make sure you have 
everything defined clearly before 

moving on. A little spontaneity will prove 
handy, but not as handy as a solid base
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GETTING STARTED
SKETCH WITHIN PHOTOSHOP

02  A CLEAR COURSE OF ACTION
Begin tightening up your line work and 

organise the shadows and lights. Eliminate scribbled 
brush strokes, as a good, solid direction early on will 
dictate the difficulty of a piece. It’s also wise to make 
sure you have everything defined clearly before 
moving on. A little spontaneity will prove handy, but 
not as handy as a solid base.

01  START YOUR SKETCH
Begin sketching the figure very 

loosely inside Photoshop on a new 
layer. This is so that you can visualise 
the proportions and composition you 
need. A three-quarter view of an owl 
moving towards the viewer has been 
chosen here. This example is the best 
design from a set of thumbnails, as it 
made sure all of the needs of the piece 
were met early on.

03  SEPARATE THE SKETCH
You’ll want to make sure that your bird is on 

a separate layer without any loose or extra strokes. 
Check for such artefacts by creating a layer beneath 
the sketch layer and fill it with a pink colour. This 
reveals any stray white and grey brush strokes in 
and around the sketch. If there are any in your 
image, you will need to erase these.

FROM SKETCH TO RENDER

WORK IN 
PROGRESS

Progress 1: Rough sketch

Progress 2: Add background

Progress 3: Create lighting

Fantasy paintings are ever so popular, with 
many digital artists plying a profitable trade 
from a range of different styles. With the 
right skill set and techniques, you too can 

create concepts for multiple parties within the 
entertainment industry. This tutorial aims to give 
you a head start.

You’ll begin with the sketch phase, drawing out 
some rough ideas in Photoshop, then you’ll 
discover essential ways to add colour, detail and 
cohesive lighting to your images. Special effects will 
breathe further life into these designs, mainly 
through the use of dramatic lighting effects that 
enhance atmosphere. 

Of course, this is all made possible using 
Photoshop tools and options. Custom brushes have 
been supplied so that you can make the marks 
seen in this tutorial. You’ll also discover ways to 
layer these new brushes, using the power of 
Photoshop’s blending modes to produce exciting 
lighting effects. 

Brushes are used to paint texture and detail, with 
Lock Layer and clipping mask controls letting you 
shape your final design exactly as you want it. Ways 
to introduce tonality and colour temperature, again 
enhancing atmosphere, are also taught. By the end 
of it all, you’ll be able to tackle your very own 
distinctive fantasy paintings.

FANTASY LIGHTING    TECHNIQUES    

MARCO NELOR
marconelor.tumblr.com

OUR EXPERT

Currently living in Chicago, concept 
artist Marco Nelor spends his time 
listening to music, drawing and 
painting. For updates on his process, 
tips and tricks, be sure to follow him 
on Twitter. 

@MarcoNelor

SOURCE FILES
On the CD, you will find all the 
brushes needed to replicate the 
effects learnt in this tutorial. Simply 
upload the advanced photoshop.abr 
file by double-clicking it.

LEARN ESSENTIAL BRUSH TECHNIQUES TO CREATE 
DRAMATIC LIGHTING AND VIBRANT COLOUR

FANTASY LIGHTING
DIGITAL PAINTING
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08  Paint feathers
It’s time to start painting feathers. To do 

this, select the brush labelled ‘700’, which closely 
resembles the hackle you can find in owls and other 
birds. Take care to not add strokes too wildly. Instead, 
apply in a uniform manner, tracing the existing 
contour in your owl’s form. This means you’ll create 
a more authentic appearance. Studying a real-world 
reference to get the right look isn’t cheating.

06 create atmosPhere
It was decided that the head would read 

better if it were in front of the far wing, so you need 
to add a little bit of atmosphere. Using the Marquee 
tool once again, select an area outlining the owl’s 
face and a portion of the wing behind it. Select a 
rounded brush with soft edges and begin stroking in 
the lighting from the top down, as your light will 
likely be a top-down lighting. 

04  add texture
Early on in a painting, it’s good to add a little texture to certain areas. Later, these earlier signs of 

texture may show through and help to pick out subtle shapes, giving the painting a bit more life. Upload the 
advanced photoshop.abr and select the brush labelled ‘20’. Paint texture near the light areas of the talon. Be 
careful to not to paint too brightly this early on, however, as increasing the contrast too soon will make areas 
seem overly bright or blown out later. 

07 form shadow
Getting comfortable with the Selection tool? 

Good, as you’re about to practise that same 
technique here by carefully selecting the legs of your 
owl. Now press Cmd/Ctrl+Opt/Alt+I to invert your 
selection. This effectively lets you paint behind the 
selected area. Use another soft brush in order to 
paint in some shadow behind the legs. Again, take 
care not to paint your marks too dark.

05  coPy and Paste
A useful trick when creating similar 

features like the talons is to use a copy and paste. 
Since the shapes will be painted over later, you won’t 
run the risk of each talon looking too similar. Select a 
talon with the Marquee tool (L), then press and hold 
the Cmd/Ctrl key as you drag the selected area to 
another location. Doing this creates a duplicate of the 
selected item. 

    quick tip 
The secret to applying textured brushes 
successfully is to build up gradual details using 
consistent strokes. Keep your textures and 
textured brushes from getting too messy, as 
they may begin to lay down too much texture 
and overpower the entire effect. 
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09  Add blAcks
Up until this point, the image will be rather 

grey. But this is fine, as it has allowed you to make 
sure that the focal point is yet to be decided. Usually, 
you’ll want your focal point to be your subject’s face. 
So it’s here that you’ll apply your first solid black to 
create the owl’s eyes. Use a Selection tool to draw 
out a good shape for these, then fill your selection 
with a solid black. This makes the eyes the darkest 
point of your piece and therefore your point of focus. 

12  RendeR feAtheRs
It’s a good idea to layer your painted feathers. Start with smaller feathers near the top of the wing 

and paint three rows. Begin with the bottom row, painting in loose feathers. Add a layer on top and paint 
values that create the shadow from the feathers that will be above that. Then paint those feathers in on a 
new layer above your shadow layer. Working backwards in this way makes the feathers appear to be 
casting shadows. 

10  hide selections
You’ll have made quite a few of these by 

now and they can be distracting. With an area of your 
painting selected, in this case the eyes from the 
previous step, press Cmd/Ctrl+H to hide your 
selection. Sometimes doing so will help you see 
what you’re doing more clearly. With your selections 
hidden, you can begin detailing the eyes, which is 
done using a soft grey brush on the outer area and a 
sharper white brush for the reflective highlights. 

11  build feAtheR textuRes
Continue painting your bird and refining 

your form and shapes. Uniformly paint the wings, 
slowly building colour until you create solid-looking 
results. Try to stay within the appropriate tonal 
range. Do this on a new layer (Cmd/Ctrl+Opt/
Alt+Shift+N). The smoother you keep your forms 
now, the cleaner your painting will be later. It’s not 
until the very end, when bringing all your painting 
marks together, that you start to fashion feathers 

13  PAint long feAtheRs
Now that you’re done with the smaller 

feathers, you need to paint a larger one. First, create 
a new layer (Cmd/Ctrl+Opt/Alt+N), then use the 
Marquee tool (L) to create a long, feather-like 
rectangular shape. Use a soft round brush to paint 
one side dark and another side a bright grey, 
manually creating a gradual gradient. This gives the 
illusion of a single feather, which is longer and 
thicker than the rest you’ve just added. 

Begin detailing the eyes, 
which is done using a soft 

grey brush on the outer area and 
a sharper white brush for the 
reflective highlights

DetaileD blueprint
Lay the foundation for focaL points, texture and form
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RendeR youR look
creaTe dramaTic lighTing, conTour and deTail in your image

14  Copy and paste feathers
Using what you’ve learnt about the Marquee 

tool and the duplicate technique, you now implement 
a combination of the two. Remember the long 
gradient feather you just painted in the last step? 
Well, now you’re going to copy and paste this into a 
new layer and slightly enlarge it. Place it so it 
overlaps the original large feather layer. Continue to 
copy, paste and place a few dozen times until you 
have a long row of feathers.

15  Break up repetition 
Build upon the last steps by repeating their 

processes, painting and placing feathers in the owl’s 
opposite wing. Make sure you follow the right 
direction for an authentic look. To break up the 
monotony of some of these feathers, erase parts of 
the edges in some of your layers. Also elongate 
some of them slightly and skew the shape of others 
a bit. This allows you to create the beginnings of a 
very interesting wing pattern for your owl. 

16  uniform lighting
Now that you’ve created your feathers, you 

will need to add larger shadows. First, merge down 
your owl layers, then make sure that this new layer 
is locked by clicking on the Lock icon located at the 
top of the layers tab. Now, apply a large, dark grey, 
soft round brush and lightly add some shadow to the 
rounded parts of the top of the wing. This makes 
sure your wings are being lit by the same light 
source as the rest of the image. 

18  seCondary light
Since the plan is to have your main light 

source closer to the viewer, a secondary light source 
can be established – in this case, the moon behind 
the owl. On a separate layer, draw a circular selection 
with the Elliptical Marquee tool. Set this layer’s 
blending mode to Color Dodge and paint in the moon 
with a few large strokes, using a neutral grey colour. 
This gives the moon its glow effect. Also use the 
same brush around the moon to give it a halo effect. 

17  start the BaCkground
Since your owl is on its own layer, you can 

create a layer beneath and begin the background. 
This image will eventually reveal a bright scene with 
sparks and cinder flying from a fire. However, to 
make these effects workable, you need a dark, 
muted background full of dark purples, dark browns 
and dark reds. While it seems dark now, adding your 
effects later will help keep the focus on your owl, 
rather than spreading the focus around haphazardly. 

    Quick tip 
When painting to a Color Dodge blending mode 
layer, using a grey colour will create a very 
natural and even glow. Painting with a saturated 
colour gives a glow similar to that colour.

     MasteRing spaRks
You’ll see that spark effects were added to the 
final image. You can recreate this effect by using 
several layers and a very easy technique. Create a 
new layer, set its blending mode to Color Dodge 
and scatter in some simple sparks with an 
orange-coloured brush. Now duplicate this layer. 
Duplicating a Color Dodge layer into itself will 
make the sparks glow even brighter than before. 
Now you must copy, paste and place your sparks 
around the image by selecting the Move tool, 
holding Opt/Alt and dragging them to other 
locations. Create depth of field effects, making 
some seem close up, others further away.
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24 Final details
In the same way as you’ve done in previous 

steps, create another layer and lock it to the armour 
layer. Set the new layer’s blending mode to Color 
Dodge and choose a saturated orange colour. Paint 
this on the side of the armour that you feel should 
receive the most light, with the brightest parts 
nearest the crease. This gives you a balanced 
exposure, and good shadow and light separation. 
Repeat the same process for the trimming. Use the 
Hair brush (brush 125) to zoom in and add more 
detail to the face, working your way outward from 
the focal point and detailing as you go.

21  Bring it Back
Since the layer below this new light layer is 

a dark brown colour, it’s possible to bring back 
shadows – just erase areas from the Color Dodge 
light layer above. Create dramatic shadows in the 
feathers by using the Marquee tool to make 
selections like in the example shown, then delete 
from these. This method is much better than 
painting with more black because the darkest colour 
has been established at this point.

23  add armour
Now that the hard part is over, you can 

begin to make some armour that fits with your 
image lighting. Use a solid colour that outlines the 
entire shape of the armour on a new layer, then lock 
it. This allows you to paint evenly over the entire 
shape, rather than painting each piece individually. 
Doing the latter has a higher chance of throwing off 
the balance of the armour. Do the same for the 
armour’s trimming. 

20  reFlective lighting
Using the same method outlined in the last 

step, create another layer, except this time set its 
blending mode to Color Dodge. Link the layer again. 
Even though it appears to be linked to the last layer, 
they’re both actually linked to the owl layer. Use this 
layer to add both blue rims of light in the edges of the 
wings and yellow lighting that emulates reflection 
from the fire. You can also erase lighting and reapply 
until you’re satisfied with the effects. 

22  Back and Forth
At this point in your painting, it’s important 

that you start to flesh out your colouring and 
continue to tweak your image lighting. You could 
also add more subtle hints of colour, perhaps some 
purple or pink hues. Always remember that if you 
want to add more lighting, then you do this 
specifically to your Color Dodge blending mode layer. 
You can take this away by simply erasing it to show 
the layer beneath.  

19  clip layers
Back with your owl and it’s time to add a 

little colour. At this stage, it’s best to keep everything 
simple – and in this case dark. Create another layer 
above the owl layer and link the two by hovering your 
mouse between the layers while holding Cmd/Ctrl. 
Click and it links the layers. This will ensure that 
anything painted on this layer will only affect the 
layer below it, which will be your owl layer and not 
the background. 

    quick tip 
Now that your major elements are completed, go 
over everything you’ve done and detail your brush 
strokes and lighting. Keep taking a step back to 
check your progress. This will ultimately help 
push the piece to final completion.
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BLUR THE BOUNDARIES BETWEEN PHOTOS AND ILLUSTRATION USING 
PHOTOSHOP’S BRUSHES, BLEND MODES AND COLOUR ADJUSTMENTS

HOW I MADE

FUTURE GAMING
MAXIME GIRAULT

Maxime Girault (maximegirault.com) is a 
French digital artist who has been 
designing with Photoshop for over ten 
years. He has only been using stock in his 

work since 2012, however, looking to blur the lines 
between photography and illustration, which he has 
successfully managed with this image. “I like the 
dynamic aspect illustration can have and the human 

TECHNIQUES    HOW I MADE

feeling photography has,” he explains. “I like to paint 
in what’s missing, cut parts of photos and change 
them as I would with a giant painted canvas.” Lots of 
Girault’s effects are laid on top of photo elements. “I 
like that there is no magic button – it’s down to the 
stylus in my hand.” To see more from Girault’s 
portfolio visit his website or Facebook page (www.
fb.com/giraultmaxime) 

© Maxime Girault

01 INITIAL CONCEPT 
Keep this as rough as possible, but still define the main idea. Dynamic lines help to create 

movement and form. A strong contrast with visible light sources helps to visualise exposure and contour.

02 SHOOT, CUT AND ASSEMBLE
The sketch is used to direct a photo 

shoot. Select the best legs, the best face and so 
on, then assemble these in Photoshop to create 
the best pose. A soft brush was used to colour the 
skin, painted to a Color blending mode layer.

03 SKIN LIGHTING 
Add a Curves adjustment layer, applying 

a downward curve. Double-click the Curves layer, 
select Blending Options, hold Opt/Alt and drag the 
Blend If white sliders to hide highlights. Edit 
effects further using the attached Layer Mask.

I like to paint in what’s 
missing, cut parts of photos 

and change them as I would with 
a giant painted canvas
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04 Paint hair 
Capturing flowing hair in a single shot is 

hard, so it is often easier to just paint the effect in. To 
do this, use a small 3-5px brush with Flow set at 
60%. Only four colours were required to paint in 
these elements. 

05 Pixel elements 
Create pixel art by opening a 100 x 100px 

document and paint with the Pencil tool at 1px. Paste 
your mark into the main image, then Scale and 
Distort it (Cmd/Ctrl+T) with Interpolation set to 
Nearest Neighbor in the CS6/CC menu.

06 holograPhic effects 
Apply a dotted pattern texture, then make a 

selection of the pixel art shape. Use this to apply a 
Layer Mask to your dots. Correct mask edges by 
hand, painting to these so there are only full-circle 
dots and none that are cut in half. Add Gaussian Blur.

08 ambient lights 
With a large brush set at 0% Hardness and 

10% Flow, paint glow over the character edges. Also 
apply effects around holograms and add your brush 
to create an ambient background light. It’s about 
linking things and making key elements stand out.

07 gold Particles 
Create gold particles around the holograms 

using a custom dust brush. Paint with rich and light 
yellow tones. Also add a mask to these effect layers 
and paint with a black brush of the same style to edit 
the strength of the effect.

Keep your concepT in mind
Stay focuSed

This image represents a videogame arena that could be 
real in few years time, with lo-fi graphic holograms made 
with motion tracking and 3d laser beams

© maxime Girault

Focus on a simple feel at first and do your best 
to stick with it until your final result. It’s very 
easy to lose your way among all your elements 
and effects. The sense of a simple black 
silhouette on a white triangle acted as my 
guide when creating this image. It’s important 
to feel what you want to express and do your 
best to cut your way through the design 
process without losing sight of this.
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kick off
import stock imagery and add adjustments

02 Import turf
Open an image of some grass, which is 

pretty easy to source or take yourself. Drag this 
image layer into your web project document. Cmd/
Ctrl-click this new grass layer and select Convert to a 
Smart Object. Place this new layer at around 650px 
down and resize the height using Edit>Free 
Transform (T) accordingly.

01 InItIal Setup
Create a new 72dpi 1280 

x 1645px RGB document. Press 
Cmd/Ctrl+R and place a guideline 
at around 700px. Create a new 
layer. Apply the Marquee tool to 
your guideline then fill with blue. 
Create another new layer, apply 
the Marquee tool to your bottom 
space, then fill with brown.

03 add a StadIum
Download the stadium image (540239) 

from sxc.hu. Add the Pen tool around it, then make it 
a selection. Select Layer>Layer Mask>Reveal All. 
Drag the stadium layer into your web project and 
make this a Smart Object. Resize and position as 
above. Apply a black to transparent gradient to the 
clipping mask to merge it with the grass layer.

pictorial layout

Work in 
Progress

Progress 1: explore the layout

Progress 2: compose athletes

Progress 3: add ui elements

Combine photos with typography and Ui 
elements to Create a dynamiC layoUt

New media

design for  
the web

Photos now play a massive role in web 
design. These are being used to convey 
messages, applied with effects that 
complement a stylised user interface. 

Photos can appear in the form of thumbnails inside 
a grid, or as large backdrops to support floating 
elements including type, icons or buttons. 

However, thought must go into selecting your 
photos so that you don’t end up disrupting your 
composition. If they clash with any other elements, 
your web design will be ruined. 

In the following pages, you’ll discover how to 
tackle photo-based web styles and produce some 
great looks with the help of Photoshop. You’ll learn 
how to create a dynamic layout using shape and 
type juxtaposed with photos.

Creating depth by pairing elements is also 
explored, as is how to add dramatic lighting effects 
using adjustment layers. Ways to transform, 
composite and edit photos with layer masks is also 
looked at, leading to an exciting end result that will 
promote your design to global viewers.  

raSmuS WangelIn
www.rasill.com

our exPert

Rasmus wangelin is a Swedish 
designer based in New York. He is a 
former Hyper island alumni, 
currently working as a design 
director at R/Ga.

original tutorial 
files used
For those interested in applying the 
exact stock images wangelin is 
using, head over to stock.xchang 
(http://sxc.hu) and www.
dreamstime.com. Below are the 
image ids for you to search for.

 dreamstime
//24768939
//24867568
//24698993

 stock.xchng
//1421859_98595171
//540239_89216828



04   SKY AND CLOUDS
Download the cloud image (1421859) from 

sxc.hu and drag this into your web project. Place it in 
behind your stadium layer. Make this a Smart Object 
too and scale it down. Also set its blending mode to 
Screen and Fill at 80%. Resize the height of the layer. 
Add a Levels adjustment layer then select Layer>
Create Clipping Mask. Drag the left slider to 45. Add a 
Layer Mask and a black to transparent gradient from 
the top down to about 200px, fading your clouds.

05 SOIL AND PLAYERS
Grab a soil image from cgtextures.com 

and import it into your project, below the grass layer. 
Open 24867568 and 24698993 from Dreamstime and 
use the Pen tool to select and cut out the football 
players. Add a Clipping Mask to both then drag them 
in. Convert these new layers into Smart Objects, 
resize them and place them hovering above your 
grass layer. Focus on making all elements interact 
authentically through size and placement.

06 SET THE MOOD
Now for colour and contrast adjustments. 

Go through every layer and adjust them until they 
work well together. Apply black to white Gradient 
Maps with layer blending modes set to Multiply and 
Screen to control lighting. Drag the black slider in 
Gradient Maps set to Screen and the white slider in 
those set to Multiply until you get good results. Make 
sure all adjustment layers are linked to the layer with 
a Clipping Mask so you don’t affect the layers panel.

07 CHANGE EXISTING COLOUR
Change a shirt to red by adding a Hue/

Saturation adjustment layer and clipping it to the 
correct layer. Set the Hue slider at +170. The players 
are very desaturated, so also add some realistic skin 
colour using a Selective Color adjustment layer and 
clip it to a player layer. Select Colors to Neutrals and 
set Cyan at +10, Magenta at +35 and Yellow at +50. 
Repeat this for the other player layer. Now cut out 
and import the 24768939 football image file. 

08 ADD TYPOGRAPHY
It’s important that different elements don’t 

compete against each other. Create a simple line 
using the Line tool and add the player names on 
each side of this. Place them slightly over the line 
and add a Layer Mask to each, then apply a black 
brush and paint out the parts that overlap. Group the 
text elements and the line, then add a Layer Mask to 
that group folder. Mask off parts where the players 
interact so you get a nice sense of depth.

    QUICK TIP 
When using different photo assets to build a 
composition, consider the space you’re working 
with. Objects in focus will naturally be sharper 
than objects in the distance. Use adjustment 
layers to colour and light correct layers so that 
they match and correspond to depth of field. 

    USING ADJUSTMENT LAYERS
By using a black to white Gradient Map set to 
Screen blending mode and dragging the location 
of the black sliders, you can control highlights. 
Drag it down to 90% and slowly start dragging to 
increase values, until the amount feels right. This 
is an effective way of adding a dramatic feel to 
your photo elements in web. You can use the 
same technique using the Multiply layer mode, 
dragging the slider to 10% to control darkness.

TECHNIQUES    DESIGN FOR THE WEB
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Working With Ui
 Add shApe lAyers And lAyer styles to creAte interfAce elements
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13 Final Tweaks
Now it’s time to add final copy and icons. Go 

through your layers and see what can be improved. 
Play around with different adjustment layers and 
colour variations, tweaking everything to get the look 
you want. Add infographic elements such as 
amounts and titles to your bar chart. Also add icons 
to your buttons, such as social platform types and 
custom shapes, for a more interactive feel.

12 BuTTons
You now want to start creating buttons. 

Draw a new shape using the Rounded Rectangle 
Tool, around 70px tall and 300px wide. Set shape 
layer Fill at 0% and double-click the layer to enter 
Layer Styles options. Now activate Gradient Overlay. 
This time use a soft gradient, setting the black slider 
at 0 and white slider at 100. Set this gradient’s 
Opacity at 25% then click OK. 

11 Bar charT
Create the bar chart UI seen in our example 

using the Rounded Rectangle tool with Edge Radius 
set to 2. Draw a rectangle about 40px tall and 300px 
wide with a #42361f colour. Draw a new rounded 
rectangle shape with a #727c20 colour and place it 
inside the original. Double-click on the layer in the 
Layers panel and choose Gradient Overlay. To make 
the hard lined gradient, set both the black and white 
sliders at a Location of 50%. Set Opacity at 8% and 
click OK. Duplicate and create more bars.

10 add layer sTyles
Add a green circle using the Ellipse tool. 

Duplicate this shape layer and scale it down, holding 
Opt/Alt+Shift, placing it in the centre of the original 
shape. Select it and add a Clipping Mask to your 
original circle shape. Double-click on your original 
circle and add Bevel & Emboss. Set Depth at 25, Size 
at 250 and Opacity at 60% to create a 3D effect. Also 
add Drop Shadow from the same Layer Styles 
options, setting Size at 50 and Opacity 80%.

09 inTroduce The ui
Set up a guideline in the middle of your image that you can use for reference when placing the UI 

elements. Add a #1f1b15 coloured rectangle using the Rectangle tool, at about 65px tall, horizontally across 
the image. Mask away the middle part using a black to white Radial Gradient and fashion it into a UI element. 

001
paste the player from the 
24768939 dreamstime file. 
duplicate, flip, then change 
the shirt colour to red

003
Unite both type elements to 
correlate content. Also make sure 
you have dedicated enough negative 
for the Ui elements

002
Add the team names in 
white and season stats in a 
# 978863 colour, then 
overlap with the players

001 002 003

Add icons to your buttons, such as social platform types and 
custom shapes, for a more interactive feel
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Create realistiC digital matte artwork using 
photographiC referenCes and digital painting

PhotomaniPulation

Matte Painting 
techniques

Techniques    Matte Painting techniques
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D
igital matte painting is achieved by combining digital 
painting with photography to achieve photorealism. 
Today, this process is widely used within the film 
industry to create fantasy settings or landscapes 

which would otherwise be impossible to shoot. In this tutorial, 
you will learn how to edit, manipulate and paint over 
photographic imagery and tailor them to a specific need in 
order to create your own fantasy matte painting. 

Once this has been completed, you will have a better 
understanding of how to use and manipulate photographs to 
your advantage in several different ways, and how to combine 

them with digital painting techniques to get the most out 
every piece. Achieving photorealism does not happen 
overnight, so use this information as a starting point to build 
upon. Once a firm grasp has been made, there are little to no 
limits as to what can be done with these techniques.

This tutorial will require some prior knowledge of layer 
masks and how to apply them via selection, quick masks and 
painting and erasing. Other knowledge includes colour 
grading and correcting, clipping masks, basic brush and 
toolbar settings, Transform tools, and some usage of the 
Clone Stamp tool.

BoBBy Myers
www.kaioshen.deviantart.com

Our expert

Myers is a self-taught digital artist 
from Orlando, FL. He currently 
resides just outside of Atlanta, GA 
where he is in his last year studying 
Visual Effects at the Savannah 
College of Art and Design.

sOurce files
Throughout the tutorial will be URL 
links to point you to locations where 
the source images used in this 
article can be found. But of course 
feel free to substitute these for your 
own imagery.
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04 Placing Extra clouds
Download the additional cloud image from www.sxc.hu/profile/ukunurk (the 

large cloud is in the centre, while the smaller one is on the left). Extract and paste them into 
the scene file. Scale and place them as shown in the image. Select the Brush tool and a 
nice cloudy brush, then paint dark and light tones on the larger cloud to create a more 
dramatic effect. The entire cloud does not need to be painted, so only paint as much as is 
necessary, as shown above.

01 sEtting uP
The first thing that needs to be done is to create a new document and place the photographic plate. Go to File>New 

and set the image size to 3000 x 1136px. Download image ID 1252246 from www.sxc.hu and place it into the scene. Use 
the Transform tools to adjust and tilt the layer. Name the layer ‘Plate’.

03 rEPlacing thE sky
Now it’s time to import the new sky. Since the old one is dull 

and doesn’t tailor to the scene’s needs, it needs to be replaced with one 
that is able to fill the void. Go to www.cgtextures.com and download 
image ID 35830, then place it into the scene as seen in the example 
image. Depending on its size, it might need to be scaled down. Use the 
Transformation tools (Ctrl/Cmd+T) to adjust the scaling and tilt.

02 thE PlatE
Now to paint over parts of the layer that aren’t needed. Select a 

soft round brush and with a dark green colour (not too saturated), paint 
over the water portion of the plate. Create a new layer and place it 
under the Plate layer. Use the Eyedropper tool to select a dark blue 
colour from the sky and using the Brush tool, paint in a small portion of 
the sky. Merge this layer with the Plate layer.

From base plaTe To 
Finished painTing

Work in 
Progress

Progress 1: Work on the plate

Progress 2: add foreground

Progress 3: Finishing details

The goal is to create realism, but going too far or too short will break 
that. Giving an even balance to everything is essential
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07 Lighting the Mountain
Grab the Brush tool and select a tree-shaped brush or something equivalent. Change the colour to a 

light yellow (not too saturated) and begin painting in the highlights on the mountain. Pay attention to where 
the sun is coming from in the base plate: right to left. If needed, lower the opacity and fill of the brush. This will 
lower the density of the brush stroke to allow a slower build up and make painting more forgiving and natural.

05 BuiLding the Base
Now start building up the base where the main mountain will be. Take the Brush tool and a good 

tree-shaped brush (with some Scatter) and paint a mountain similar to the example image. Colour doesn’t 
matter, as you’ll be overlaying it with texture later. At this point it’s a good idea to map out how the light will hit 
the mountain, which will be useful when texturing later on. Paint lighter tones to simulate where light will be. 

08 BuiLding the Background
There are several different ways to create the mountain shapes. One is to create a selection and fill it 

with a colour, and another is to use the Brush tool and paint it. Use whatever is most comfortable. The goal is 
to create realism, but going too far or too short will break that. Giving an even balance to everything is 
essential. Download image ID 78057 from www.cgtextures.com and paste it into the scene. Clip it to the 
base layer and position and scale it as needed. Create a new layer, clip it and paint highlights and shadows 
onto the mountains.

06 texturing the Mountain
Search for images 1273649 and 1252247 

on sxc.hu. Extract and paste them into the scene. 
Using the Transformation tools, set them into place 
as you see in the example. Use the Clone Stamp tool 
and begin cloning parts of the textures to cover the 
painted areas. Make certain that there are no 
repeating patterns. Clone parts of the tree texture 
over to the front of the mountain to make it match 
the example. If necessary, paint extra detail into the 
rock to make it look more rigid.

09 adding WaterfaLLs
Download image 1337592 from sxc.hu and 

paste it into the scene. Use the Transformation tools 
to adjust and tilt the image appropriately. Use a layer 
mask to hide the top, bottom and side areas. With 
the Brush tool and a dark cool blue, paint a shadow 
on the top half of the waterfall, just above the rocks. 
This will act as the cast shadow from the castle. On 
the lower half, paint in the remaining highlights and 
shadows. Remember what direction the sunlight is 
coming from. The other waterfalls were painted with 
a chalk brush.

    quick tip 
It’s tempting to paint as much as you can, but unless you’re working in a high resolution, the best way to 
obtain photorealism is to let the photographs do most of the work. As your painting skills increase, so too 
will your knowledge of how to use those references.
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12 Painting and Lighting
Use the Eyedropper to grab a selection of grass and stone colours from the texture and store them in the Swatches tab. 

Get your brush and use these colours to paint extra grass and rock to create added detail. Once done, create a new layer and clip 
it to the base layer. Get a light yellow-orange colour (not too saturated) and paint highlights onto the front side of the mountains. 
Paint shadows using a dark blue colour on the other side so that they don’t appear flat.

001
Paint along the edge where the light 
meets the shadow to create a crisp line

004
The edges should not be too bright or the 
mountain will appear flat

003
colour pick from the texture and adjust it 
to a lighter tone for the highlights

002
use multiple dark colours to paint extra 
cracks in the mountain rock

001 002 003 004
    quick tip 
Layer masks are a great way 
to edit non-destructively. They 
can hide and show parts of a 
layer at any time due to the 
contents of the layer itself 
never being erased, but only 
hidden. If needed, they can 
always be merged with the 
layer to lower the file size.

10 Creating Foreground Mountains
Much like in the background, you can create the foreground mountains by making 

a selection and filling that with a colour, painting, or any other method. The main idea 
behind these mountains is to lead the viewer’s eye up towards the castle (main focal point). 
By pointing them upwards, it would create an implied line that leads to this focal point. 
Once the mountain bases are created, they will be used as a clipping mask for the textures. 
Name this layer ‘FG mtn base’.

11 adding texture
Go to CGTextures and search for image ID 82231. Click on the 

image and choose any of the ones that appear. Then repeat for ID 82144 
and choose the image on the far right. Extract and paste them into the 
scene. Place them above the FG mtn base layer you just created and 
clip them to the layer. The textures will now only appear where the base 
layer is. Position the textures into place and use the Transformation 
tools if needed. Unclip the layers from the base if there is difficulty 
positioning them, and then re-clip them. The goal here is get as much 
balance between rock and grass as possible.

13 PLaCing the trees
Download the trees 35864 from CGTextures 

and 841073 from www.sxc.hu. Extract and paste 
them into the scene. Go to Layer>Matting>Defringe, 
set it to 2px and hit OK. Use the Transformation tools 
to scale and position them according to the example 
image. Create two new layers, set them to Overlay 
and clip each to their respective tree layer. Grab the 
Brush tool and with a light yellow-orange colour, 
lightly paint in highlights on the trees. With a dark 
cool blue, paint shadows on a separate layer (set to 
Normal blending mode).

14 Creating the CastLe
The 3D model of the castle was created in 

Autodesk Maya. It was box-modelled from a cylinder 
and primarily extruded and bevelled to give the 
desired look and feel. Other objects were created 
from spheres and spline elements. Texturing 
consisted of Substance materials within Maya and 
rendered with V-Ray. Before rendering, the main 
castle was duplicated, scaled, rotated and reordered 
several times to create a denser look for the final 
matte painting.

15 iMPorting the CastLe
Once the castle has been created either by 

3D modelling or piecing together photographic 
references, paste it into the scene and make it a 
group if it contains multiple layers. Adjust its position 
and tilt using the Transform tools. Create a layer 
mask for the castle layer. Select the Brush tool and 
with the colour black, paint near the bottom of the 
castle to hide this part. Be sure to paint on the layer 
mask and not the layer itself. Use tree-shaped 
brushes if possible for added detail.



The main castle was duplicated, scaled, rotated and 
reordered several times to create a denser look
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20 Finishing Detail
Like the Arch, use the Elliptical Shape tool and draw out a circle. This will be the 

rainbow. Copy it, make the duplicate smaller and place it in the centre of the larger circle. 
Cmd/Ctrl-click on the smaller circle to make a selection and delete this portion from the 
larger circle. Now apply a Rainbow Gradient Layer Style to the larger circle and Gaussian 
Blur it 10-40px. For the low-lying clouds, select the Brush tool and get a soft cloud-shaped 
brush. Using real clouds as a reference, paint them along the bottoms of the mountains.

21 Colour graDing
Go to ‘Photo Filter’, change the colour to a greenish cyan and 

set the Density at 32%. Create a new Color Balance and change the 
following; Shadows: Magenta/Green +1, Yellow/Blue +4, Midtones: 
Cyan/Red +16, Highlights: Cyan/Red +1, Yellow/Blue -16. Create a 
Gradient Map and set the left side to black and the right to white. Now 
change its layer Opacity to 40%. This is a good base to work from, so 
feel free to make changes and experiment.

19 lighting anD extras
Create a new layer above the arch group and 

clip it to it. Select a soft round brush at about 
200-400px and change its colour to a light yellow 
(not too saturated). Lightly paint a highlight near the 
middle of the arch to simulate the sun lighting it. The 
triangle was achieved by painting with a hard brush. 
Inner Shadow, Drop Shadow and Inner Glow were 
used as layer styles to create the outer bevels.

17 ConstruCting the arCh
Use the Elliptical Shape tool to draw a circle. 

Copy it, make the duplicate smaller and place it in 
the centre of the larger circle. Cmd/Ctrl-click on the 
smaller circle to make a selection and delete it from 
the larger circle. Delete the small circle and the lower 
half of the original. Duplicate it, scale it down and 
place it under the arch. Set its Opacity at 70%. Group 
these together and position them in between the 
background mountains.

18 aDDing the texture
Download http://farm3.staticflickr.com/22

82/2179154776_65a486debe_o.jpg, clip it to the 
arch base layer and set it to Overlay. Set Opacity at 
70%. Hit Cmd/Ctrl+T to activate the Transform tools. 
Ctrl/right-click and select Warp. Now adjust the 
texture to the shape of the arch. Hit Enter to apply 
the warp. With the texture adjusted, feel free to erase 
the remainder of it that is not being used. If needed, 
desaturate the texture by hitting Cmd/Ctrl+Shift+U.

16 lighting the Castle
Even though the castle itself has been 

previously lit, it could still benefit from some 
dramatic lighting and increased intensity. With the 
Brush tool, a soft round brush and a dark cool blue, 
lightly paint a shadow at the top of the castle. This 
will decrease the focus brought to this area and 
increase the focal point. Next, pick a light yellow-
orange (not too saturated). Create a new layer and 
set it to Overlay/Soft Light. Now lightly paint in 
stronger highlights on the castle to simulate harsh 
sunlight. If needed, paint additional shadows on the 
other sides.



HOW I MADE

POP BIRD
THERESE LARSSON

T his illustration is part of a series that was 
created to advertise Metro Sweden’s 
sponsorship of the Eurovision Song 
Contest. Each bird is a playful caricature of 

a famous Swedish pop star. Digital illustrator 
Therese Larsson (www.sillybeastillustration.com) 
chose to portray a certain young, popular music 
artist as a sparrow, which she felt represented this 
person’s boy band status and young, energetic 
persona perfectly. 

SEE HOW THIS DIGITAL ARTIST CHARACTERISES POP STARS 
USING PHOTOSHOP PAINT AND LIGHT TECHNIQUES

The bird itself was painted from scratch, using a 
few different Photoshop brushes that Larsson 
collected over the years. “The background was 
modelled in 3D by Mattias Frodlundh (www.
behance.net/morrispinewood). Light effects were 
painted on top, merging the two pieces together in a 
way that looks wholly authentic,” she explains. “I 
studied a lot of light effects, but also worked light 
beams into the image using stock photos and 
blending modes.”

The background was 
modelled in 3D and light 

effects painted on top, merging 
the two pieces together

02 ADDING LIGHT BEAMS 
I added stock photography of real light 

beams as new layers, then set blending modes to 
Screen. I erased from and added to these layers 
using brushes and layer masks, working the light 
into the scene.

03 ADDITIONAL DETAILS 
As this is a show bird, I felt that he needed a 

more dramatic stage light. I also wanted to make the 
scene feel alive and not overly clean, so I added dust 
particles to make the environment more realistic.

01 PAINTING THE FEATHERS 
Realistic feathers are an important part of this image. I took 

my time to study photos of real bird wings, trying to get the structure 
right. There were no shortcuts, just a lot of effort.
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Software at the ready 
Source referenceS and Sketch a mock-up

02 Mock up In photoshop 
Open a new file at the size you wish. 

Usually, around A3 is good. I had an idea of the basic 
shape I wanted my owl to have – quite a stylised, 
graphical shape – so I began by drawing this straight 
in using the Pen tool.

01 collect references 
Begin by collecting your 

reference imagery. Flickr is good 
for this, as is a Google search. It’s 
always useful to look at photo 
references to get around your 
subject, in this instance how an 
owl looks. I tend to make rough 
Photoshop mock-ups with found 
imagery as a guide to draw from.

03 create and reflect 
Using the Polygonal Lasso tool and the Cut 

and Paste commands (Edit>Cut/Edit>Paste), create 
half of the owl image using a composite of your 
reference images. Because I want this image to be 
graphic, a reflected style will work well. Duplicate the 
half and use Edit>Transform>Flip Horizontal.

deSign hypnotic vector 
imageS with real depth

work in 
ProgreSS

Progress 1: Duplicate and flip

Progress 2: Shade and depth

Progress 3: Gaussian finish

learn how to create a shaded vector illustration by combining 
illustrator and PhotoshoP techniques

 graphics

work with vectors

This tutorial guides you through the process 
of creating a fully shaded owl illustration in 
vector form and then in Photoshop. The 
use of bold, pattern-based linework and 

powerful psychedelic shapes coupled with strong 
shading make this an eye-catching piece of design, 
but there is plenty of room for you to make the final 
result your own. During the drawing phase, you can 
add your own style or even choose another subject. 

To complete the tutorial, you will need access to 
a printer and scanner to make your drawing. 
However, it is also possible to skip this stage and 
instead create your half-owl using only vector 
patterns. If you choose that option, ignore steps 4-6 
and use the Shape tools in Illustrator instead.

Before starting, it’s worth gathering plenty of 
reference pattern imagery, as patterning is what 
really helps the piece become more than a standard 
owl image. Take a look at Art Nouveau, heraldry-
style patterning and contemporary designers for 
inspiration. The two main shading techniques you 
will learn are the use of the Blend tool in Illustrator 
and gradients in Photoshop. The Blend tool enables 
you to draw two separate lines that run parallel to 
one another and then fill the gap in-between these 
with a selectable amount of keylines and blend 
them into one shape. Gradients give you a smooth 
blend of colour from one tone to another, or even 
through a multitude of hues. Follow along to build 
your own stylish vector creation.

work with vectors   techniqueS  

olIver Munden
www.megamunden.com

our exPert

MEgaMUNDEN combines nature’s 
creatures, tattoo design, eighties 
skate graphics and an essence of the 
Far East. past clients include British 
airways, Nike, Toshiba, penguin and 
New scientist magazine.
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Create the line art
Use a composite of photo references to gUide yoU

08 Clean 
it up 

Using the 
Dodge tool set 
to Highlights 
and an opacity 
that doesn’t 
compromise 
the line quality, 
clean up your 
drawing. An 
Opacity of 
around 50% 
works well.

07 DupliCate 
anD flip 

Once you have exactly 
half of the owl in 
position, duplicate that 
layer. You can then go to 
Edit>Free Transform, 
Ctrl/right-click on the 
layer within the image 
and select Flip 
Horizontal. Adjust the 
second half into position. 
Now merge the two 
layers of your drawing.

04 print anD Draw 
Now print out your reflected composition, 

preferably at A3 size. Using tracing paper, begin to 
draw out half of the owl by hand. I wanted my subject 
to be very ornate and decorative, so I added my own 
swirl details.

09 into illustrator 
At this point you need to save out a JPEG of 

your Photoshop document and place it into Illustrator 
(File>Place). In the Layers palette, double-click on 
the layer you see and set it to Template mode, with a 
Dim amount of 50%. Now cover half of the design 
with a white block and lock the layer so you cannot 
edit it.

05 Half Drawn 
You really only need to draw half of the 

piece, as I have in pencil. You may find you make 
mistakes, so you can always make a tracing of the 
sketch for the final design. This may help progress 
the image from the rough stages, which is a bonus.

10 traCe 
It’s time to begin tracing – the longest stage 

of the process. Use the Pen tool for this as it offers 
the most control. All you need to focus on is creating 
single lines and closed shapes that directly trace the 
drawing below. Do this on a separate layer.

06 sCan anD reCompose 
Scan in your drawing once you are happy 

with it and bring it into Photoshop. If you drew 
slightly more than half, crop the drawing so you have 
an exact line of symmetry. Position the drawing over 
the top of the mock-up.

11 BlenD veCtors 
In a few areas I used the Blend tool to create 

some really nice shading effects. This works when 
you draw to fairly parallel lines (even if they are 
curved), select the Blend tool in the main palette and 
click on each of the two lines. Go back to the Tools 
palette and click on the Blend tool symbol. This 
opens a dialog box where you can choose Specified 
Steps and adjust how many blending lines appear 
between your two existing marks.

techniqUes   work with vectors



Shade in PhotoShoP
Add depth And interest with grAdients

12 Patch in 
There might be times 

when the Blend tool gives some 
undesired results, or times when 
you simply need to cover a 
section of the linework. Do this by 
creating a solid shape and filling 
with black.

14 Make Patterns
 I used a section of a photo I took, adjusting 

the levels until there was clear black and white (I did 
this in Photoshop via Image>Adjustments>Levels). 
Once this was complete I brought the image into 
Illustrator and used the Live Trace option to convert it 
to vectors, setting Threshold to 128 and Blur to 0px.

17 stroke width 
It’s good to only have a small number of line 

weights going on in your piece. In my version there 
are only two – 3pt and 1pt. Hold Shift, select the lines 
you want to be the same size and use the Stroke 
dialog to choose your width.

18 Back to PhotoshoP 
Once you have drawn up all of your owl, copy half of the lines and paste them into an A3-sized 

Photoshop document. Duplicate the layer and flip it horizontally to create your full composition. I wanted to 
adjust the eyes a bit in Photoshop, so I copied them separately.

15 cliPPing Masks 
This pattern will be used for the eyes. To 

hide the square edges of the pattern I used a clipping 
mask. This is done by drawing a space over the area 
you want to keep, selecting both the shape and the 
pattern, and using Object>Clipping Mask>Make.

16 details 
The owl half will now be coming together. 

Add some geometric shapes to create patterning. 
I’ve used circles a lot in this image.

13 Untidy Blends 
Sometimes you may 

need to tweak the effect of the 
blends. Adjust the lines between 
the initial two by selecting them 
and choosing Object>Expand. 
This will enable you to edit all of 
the curves in the blend.
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19 Shading and depth 
On the linework layer, use the Magic Wand 

tool to pick out the areas you want to highlight. Once 
you have made a selection, you will need to create a 
new layer and fill it with a solid colour. Double-click 
to view the Layer Style dialog box, select Gradient 
Overlay and then click on the rectangle to open the 
Gradient Editor. Adjust how you want the shading to 
appear and pick your colours. Repeat this step all 
around the image until you are happy with the 
shading balance.

20 Colour half 
It’s important to remember to only colour 

half to save yourself the workload. Once you’ve 
coloured, flip the shading layers horizontally after 
duplicating them.

21 expand your SeleCtionS 
You can use the Expand dialog 

(Select>Modify>Expand) when shading. This enables 
you to make a Magic Wand selection then expand it 
by pixel rate. When you fill that selection with shade 
you will not get any gaps or odd joins in colour.

22 eraSe inStead of gradientS 
To get more control than with the gradient 

technique, fill an area with solid colour and, with the 
Eraser tool on a low opacity setting, slowly erase 
some of the colour from the edge.

24 foCuS on the eyeS 
Draw a loose oval around the owl’s eye 

area with the Lasso tool. Invert your selection (Cmd/
Ctrl+Shift+I) and Ctrl/right-click on the selected part 
to bring up the drop-down menu. Select Feather and 
enter 100-150px. Press OK, then the Backspace key. 
This will add a bit of subtle highlighting around the 
owl’s eyes.

25 gauSSian finiSh 
To finish the piece I added a mild Gaussian blur to the flattened 

art layer, but not the top layer that is set to Screen. This helps to keep 
the eyes sharp and the rest a little softer. I set the blur to 1px. Save out 
and you’re done.

23 add Some punCh 
Once you have shaded to your heart’s content, select all (Cmd/Ctrl+A), copy all (Cmd/Ctrl+Shift+C) 

and paste the copy into a new layer set. Now duplicate the new layer and set the blending mode to Screen.

    Quick tip 
The owl design has been 
composed by creating half of 
the design, then copying and 
flipping it. But one little detail 
can let you down if you’re not 
careful: the eyes. As we 
know from manga artwork, 
the catchlights in the eye 
govern a lot of expression 
and show the direction the 
subject is looking in. Make 
sure that the catchlights in 
the eyes (including the owl’s 
third eye) are consistent and 
all point in the same 
direction. Remember that 
they’d all be reflecting the 
same light source at the 
same angle.  
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We take an in-depth look at dell’s flagship all-in-one touch screen 
computer and investigate hoW compatible it is With photoshop

dell XPS One 27 with 
tOuch Screen OPtiOn

operating system:  
• Windows 8

£1,449
$1,650

www.dell.co.uk / www.dell.com
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t he XPS One 27 with optional touch screen 
is, by design, a very tactile all-in-one. With 
its sleek black screen and brushed metal 
frame, the urge to touch and engage with 

this computer is undeniable. Optimised for the 
Windows 8 touch interface, its edge-to-edge 27-inch 
display delivers one of the best touch screen 
experiences on the market, making it clear why it 
has become Dell’s flagship model.

The device is aimed at creative professionals who 
are happy paying a premium for a machine that has 
high performance and power without sacrificing 
style. The bright, crystal-clear 2550 x 1440px 

resolution screen makes it an ideal fit for 
photographers, designers and retouchers used to 
working with detailed images. 

The varieties of XPS One 27 with touch all run with 
the latest 4th Generation Intel Core processors, 
which offer the speed needed to run Photoshop CC at 
a professional level. As well as being a great 
computer to create new work on, it also showcases 
images beautifully to clients. This is where the touch 
screen comes into its own, letting you smoothly 
zoom into massive resolution images and explore 
finer detail. 

Here, the top-of-the-range model with a 
super-fast Intel Core i7 processor and 16GB RAM is 
put to the test. This is Dell’s latest all-in-one range, 
and it packs a surprising amount of power and 
functionality into such a compact unit. The XPS One 
27 platform has been available for some time 
without touch, and its tough chassis has the stability 
needed for a touch device. 

A sturdy build and resistant screen means the XPS 
One 27 with touch will stand the pressure of being 

poked and prodded by even the most heavy-handed 
of users. This makes the device’s weight very 
noticeable, which in fact is a good thing. Its solid 
brushed metal base anchors it to the desk and 
allows you to use the dual hinge articulating stand to 
position the screen, so that you can work naturally 
and creatively with touch. 

The machine also takes full advantage of 
Windows 8’s touch screen features. The navigation of 
Windows’ new tiled Start screen is quick and 
seamless, allowing you to intuitively explore the 
operating system using only touch demands. The 
traditional Windows desktop mode is harder to use, 
however, as the layout is more detailed and the icons 
and menus are easier to miss. It’s at this point that 
you may find yourself moving back to a mouse or 
graphics tablet.

The touch functions on the XPS One 27 are 
incredibly smooth and intuitive when using Windows 
8, but unfortunately the touch interface is not as well 
supported across a host of other contemporary 
applications that were tested. It is this aspect that we

The 4th Generation Intel Core i7 processor allows you to work at speed even on the most detailed composites, artwork: Andrew Brooks
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BUILT FOR TOUCH
THE BEST XPS ONE 27 FEATURES

■ HIGH-SPEED PORTS
The XPS One 27 with touch has multiple 
high-speed, easy access ports. These 
include six USB 3.0s and Thunderbolt. A 
HDMI input also means this device can 
function as a stand-alone screen.

■ CRYSTAL-CLEAR DISPLAY
The eye-catching screen has 33 
per cent more pixels per inch 
than Full HD, delivering solid 
colour reproduction and image 
clarity through a whopping 2550 
x 1440px. This makes it the 
highest resolution display 
available on a Windows 8 touch 
all-in-one.

We look at some of the key features of this 
well-thought-out device that make it suitable for 
a busy creative environment. With its screen 
clarity, high-speed ports and innovative new 
touch features, the XPS One 27 touch packs in a 
lot of functionality and new design ideas for you 
to explore.

■ OPTIMISED TOUCH INTERFACE
The XPS One 27 with touch is designed to take full 
advantage of the touch functions on the Windows 8 
tile-based operating system. The ten-finger capacitive 
screen works well with all the Windows 8 gestures, 
allowing pinch zoom, rotate and swipe gestures, 
among many others.

■ STAND BUILT FOR TOUCH
It’s simple to move from a 
standard upright monitor 
position to one almost parallel 
with the work surface. This is 
perfect for touch input, and the 
solid two-point articulating 
stand also allows for some 
height adjustment.

REVIEWS    XPS ONE 27



083

will now turn our attention to, investigating just how 
compatible it is with some of the key digital imaging 
programs on the market.

Adobe Photoshop only offers the most basic 
touch functions on the device. Currently, Photoshop 
does not recognise any multi-touch gestures, and 
treats any touch input as a simple left-click with the 
mouse. This slows productivity down when 
compared to a mouse or a graphics tablet. Also, the 
paintbrush and zoom tools only function when you 
start by clicking at a point outside of the image, 
which effectively makes this touch screen 
unworkable with Photoshop right now.

It fared better, however, with Adobe Illustrator. This 
software responds impressively to multi-touch zoom 

and pan, letting you explore the image as well as 
apply smooth freehand paint effects and line 
drawings. But even this was more awkward than 
using a mouse or graphics tablet. The nature of 
complex image-making software like Photoshop 
and Illustrator means that many functions are 
displayed at one time, and these need to be so 
compact that they’re very easy to miss when using 
touch, particularly when the screen is at an angle.

The stripped-back, uncluttered interface used in 
the simple apps we tested, such as Fresh Paint and 
Photoshop Express, worked best and felt very 
intuitive and creative. Perhaps for Photoshop to truly 
embrace touch, there needs to be the ability to switch 
with the click of a button to a more stripped-back 

We found that Illustrator works better with touch, allowing for smooth zoom and movement of the images, along with impressive freehand 
drawing functionality

version of the software – one with bigger, clearer 
icons that focus on Photoshop’s drawing and painting 
functions. This could then allow you to make the most 
out of Photoshop’s Brush tool and creative paint 
effects, and to really unlock the software as a 
freehand application.

Bar this obstacle, the XPS One 27 with optional 
touch remains one of the most powerful and 
impressive all-in-one devices on the market, which 
will handle Photoshop and other software with 
consummate ease. Delivering superlative visuals is 
assured, but the elephant in the room is whether the 
extra costs of a touch screen system can be justified. 
While industry-leading software and hardware remain 
out of touch, it’s hard to say yes.

CONSIDERING AN
ALL�IN�ONE?

A LOOK AT THE PROS AND CONS OF 
ALL-IN-ONE COMPUTERS

All-in-one devices bring the computer’s 
components into the same compact case as the 
screen to keep things portable and your desk 
uncluttered. In the past, all-in-one computers 
have been hard to upgrade, but manufacturers 
have addressed this problem by designing 
easy-access upgrade ports for off-the-shelf 
components. For all of the convenience of an 
all-in-one, it’s worth bearing in mind two 
possible issues: due to the tightly packed 
components, some all-in-ones are been prone 
to overheating. Also, if there are problems with 
the computer or screen, it may be necessary to 
buy a new system instead of only having to 
replace one component.To paint in Photoshop on the XPS One 27 with touch is awkward 

because you have to start from outside the image space

VERDICT: 3/5
The XPS One 27 is an impressive hi-spec 
device with a wonderfully vivid display. It 
effortlessly runs creative software, yet it 
lacks touch compatibility with some of 
them. However, the dedicated apps offer 
a glimpse at its potential when and if 
these programs become touch-ready.

This also happens when using the Zoom tool, making it hard to 
navigate your composition and work on an image
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Touch apps To 
work wiTh
A look At other desktop ApplicAtions thAt 
enrich your Xps one 27 touch eXperience 

With many apps still to be made available on the XPS 
One 27 with optional touch, here are some of the 
best already existing. Take a look at those that help 
photographers in the studio and show how 
Photoshop can take a step closer in evolving into a 
touch screen-compatible application with this device.

02 PhotograPhy toolkit
•£0.99 / $1.49 

The XPS One 27 with optional touch is a great 
computer for photographers, with its crystal-clear 
2550 x 1440-resolution screen providing rich colour 
reproduction and detail. This makes it great for 
showcasing work to clients and peers. With this in 
mind, photographers should take a look at 
Photography Toolkit, which is a big help to 
studio-based photographers. Simply enter the 
camera and lens you are using and the Toolkit will 
calculate the depth of field, tilt shift, field of view 
and the exposure in different lighting conditions. All 
very useful tools when working on high-end 
photography where precision matters.

01 Fresh Paint
• Free 

This simple painting app is built to make the most of 
the large and responsive touch screen as a tool for 
freehand image making. It’s lots of fun to use and 
feels remarkably close to oil painting. The ability to 
work into pre-existing photographs can turn any 

photographer into a budding Van Gogh. Sampling 
colours and using the brushes to push around the 
detail of the photograph creates wonderful painterly 
results. This software also offers an insight into how 
the sophisticated brushes and textures of Photoshop 
could open new angles for digital image making, if 
Adobe embraces touch screen technology.

The easy-to-use interface 
could be a good template 

for a touch-ready version of the 
full Photoshop software

03 adobe PhotoshoP exPress
• Free 

At the moment, many of the applications that take 
full advantage of Windows and the XPS touch screen 
features are simply scaled-up versions of tablet and 
smartphone apps. Photoshop Express is a case in 
point, with simple features such as red-eye removal, 

basic colour correction and an array of filters. 
Although it’s an app with few features, it does use 
the touch screen very elegantly, with multi-point 
gestures allowing you to smoothly zoom into the 
picture and rotating the image to crop. The 
easy-to-use interface could be a good template for a 
touch-ready version of the full Photoshop software.

reviews    XPS One 27
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ecording colour inspiration has never been 
easier with the new Adobe Kuler app for 
iPhone. Using the device’s built-in camera, 
you can capture and retrieve existing tones 

from your photos. Just fire up the Kuler app and hit 
the camera icon at the foot of the interface. Activate 
the Eye icon in the bottom-right of the subsequent 
interface and Kuler will automatically present live 
colour markers. Tap the screen to freeze everything, 
then use your fingers to drag these markers and set 
new colours – similar to using Photoshop’s Color 
Picker>Sample Ring.

It’s this ability to customise your colour choices 
that makes this app so great. You can also fine-tune 
your tonal selections using RGB sliders and a colour 
wheel. Activate these from the home interface, or by 
saving out your colour theme, then clicking the Slider 
icon to the left of the Theme options. Here you can 
hold and drag R, G and B sliders with your finger, 
editing individual colours in real-time. Web designers 

Adobe Kuler
www.adobe.com
• Free • iPhone 3GS, iPhone 4, iPhone 4S, optimised for iPhone 5. Requires iOS 5.1 or later

RecoRd and shaRe youR colouR 
inspiRation in an instant

Verdict: 9/10
The Adobe Kuler app for iPhone lets you 
create great colour theme results, 
whether you mean to or not. 
Experimentation makes the interactive 
options even more entertaining.

From Kuler to PhotoshoP
Discover how to quickly transfer your swatches between platforms

reviews    Adobe Kuler
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■ Create your Kuler theme
Capturing your theme is easy. Simply fire up the app, 
click the Camera icon at the bottom of your interface 
and take a snap. Click Theme 1, rename it, then 
choose Save Changes. Click the Options icon in the 
top-right of the interface and select My Account from 
the fly-out menu. Enter your Adobe ID.

■ adobe Kuler Web app
Now you will need to activate the Adobe Kuler web 
app. You can do this through Creative Cloud or by 
accessing it at www.adobe.com. Use your Adobe ID 
to log in and then choose My Themes from the top 
toolbar. You’ll see that your themes created in the 
app version have been instantly updated online. Drag 
the cursor on top of the one you want to use and 
click the Download icon. 

■ load to your sWatChes
There are two ways to upload your theme into 
Photoshop from the Open dialog box. Choosing Open 
with Adobe Photoshop CC will import your colour 
theme straight to your Photoshop Swatch panel. 
Alternatively, you can choose Save File and 
designate a folder to store your ASE files, uploading 
the ones you want through the Swatches>Load 
Swatches option.

The app is easy to 
employ, as you use 

the device’s built-in 
camera to capture and 
retrieve existing tones 
from your photos

will notice how HEX values are similarly updated in 
an instance. It’s at this point you’ll notice the Color 
Wheel icon nestled in the top-right of your screen. 
Activate this and individually select colours, or apply 
a colour theory presets to update all points 
simultaneously and save time. There are eight to 
choose from, including Analogous, Monochromatic, 
Triad and many more. A brightness wheel can also 
be activated from the outside of the colour wheel, 
scrolled through with your finger to edit results.

All the themes you create can be instantly synced 
to your Kuler web app, but make sure you use the 
My Account option to log in with your Adobe ID. This 
is especially advantageous for Adobe Illustrator 
users, who can access personal themes using the 
Window>Kuler panel. Sadly, no such option exists for 
Photoshop users as yet, but we expect that update 
sooner rather than later. However, it is possible to 
upload your Kuler colour themes into Photoshop, 
and here we show you how. 



Digital artist steve Horsfall Discusses How He uses ligHting anD 
otHer PHotosHoP tecHniques to builD His work 

reader interview

The key To  
realisTic images

reader interview   The key To realisTic images

Steve HorSfall
www.stevehorsfallphotography.com
http://www.advancedphotoshop.co.uk/
user/photosnapper

Our reader
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Creation of Giants: One of my own concepts, i put together readouts and images relating to human genetic makeup alongside the 
giant body to create the impression of scientific creation

Mastering realism when manipulating 
images is never easy, which makes 
digital artist Steve Horsfall’s images 
even more complex. Starting off using 

PAINTSPA and a Nimbus while at school, Horsfall 
has come a long way. Take a look at more of his 
work and learn how he works with Photoshop to 
build his images.   

HOw wOuld yOu describe yOur style?
I like to think of it as alternative and cinematic. All of 
my portraits have now become composites, and I 
shoot all models in the studio and add the 
backgrounds later. Although it is rare for me to shoot 
true HDR backgrounds, I still try to bring out a certain 
amount of detail to make the image look that bit 
more edgy, and tend to keep everything in focus 

rather than having a shallow depth of field. Quite 
often I will add a cross process grade to stylise the 
image even further.

wHicH artists Have influenced yOu?
From a photographic background but still based 
around composites, I would say Joel Grimes has to 
be my initial influence into the composite portrait 
imagery I produce. His fantastic three-light, edgy 
technique is one that I have used so many times to 
help blend my subjects into the background plates. 
Dave Hill and Glyn Dewis are also big photo and 
retouching influences.

As I progress more into concept and matte 
painting, Dylan Cole, Yanick Dusseault, Ryan Church 
and Andrée Wallin are all exceptional at their craft of 
creating cinematic art.



Clockwise from  
top left; 

The Migration:  
To help increase 
the extreme 
weather for this 
unlikely migration, 
I added blurred 
snowflakes over 
the whole image. 
All of the animal 
shadows were 
tinted blue to 
match the 
background values
 
The Final Shot: 
To give a different 
look, I applied a 
vintage texture and 
tone on top of the 
composite and 
placed the bullet 
holes with a Screen 
blending mode

The Time 
Traveller: I used 
layer masks to 
brush through the 
different backdrop 
elements, and then 
used a custom 
brush and Warp 
tools to create the 
time gate

It is rare for me to shoot true 
HDR backgrounds, but I still try 

to bring out a certain amount of 
detail to make the image edgy



I brushed in some dust and atmospherics 
to help separate the foreground and 
emphasise the land contours

With two main light sources, care had to 
be taken to show the effects they had on 
surrounding items correctly

I brought 3D models into the image and 
colour corrected them to reduce visibility 
towards the horizon

088

The Ocean’s Return: Accurate colour correction 
and shadows were key to this image to help 
ground the boats with the landscape and give 
the appearance of them being partially buried



THE KEY TO REALISTIC IMAGES   READER INTERVIEW

HOW DO YOU THINK OF THE CONCEPTS FOR 
YOUR WORK? 
I’m a huge movie fan, especially sci-fi and anything 
with great visual effects. I have shelves full of 
‘Making of’ and concept art books that help to inspire 
me, so I try to add something out of the ordinary in 
each image I create. The talent in the shot and the 
background plate may appear quite normal but 
flames, swords or magical glows are never too far 
away! Sometimes when I’m out taking photographs, 
it can be the landscape around me that prompts a 
concept, or lyrics from the music I am listening to. 

DO YOU WORK WITH STOCK PHOTOGRAPHY 
OR ANY OTHER SOFTWARE? 
I use a mixture of both my own photographs and 
stock images. If a person is to appear in the image, 
then I will almost always shoot them in the studio, 
extract them from the background and comp them 
into the scene. As my work becomes more diverse, 
I have started to use 3D software and stand-alone 
renders to add elements to my artwork. This has 
meant that I now also use Photoshop to create my 
own texture maps to apply to 3D models.

HOW DID YOU GO ABOUT CREATING YOUR 
DETAILED LANDSCAPE IMAGES?
The first step is the story. This gives me a clear idea 
of what the image should contain, and from that I will 
produce a quick greyscale sketch that indicates the 
perspective and distance values. Selecting either a 
photo of my own or a stock image to set as a back 
plate, I will begin adding masked out elements on 
individual layers such as buildings, mountains and 
foreground items, scaling and distorting as I go and 
where possible selecting correctly lit elements to 
minimise retouching, all while making them fit as 
closely as possible to my initial sketch. Once the 
items are in place, I will create adjustment layers for 
colour balance, shadows and highlights, paint
atmospherics and add overall grading.  

HOW DO YOU CREATE THE ELEMENT OF 
REALISM IN YOUR IMAGES?  
Well thought-out lighting is the key to creating a 
realistic artwork. I always make sure I identify where 
the light sources in the image are and edit all the 
contents to suit. It is important to take note of 
shadows, colour temperature and reflections so that 
everything gels together nicely. Where shadows are 
concerned, making sure they still have some detail 
and colour and that highlights wrap around objects 
where they are required to helps to blend them into 
their surroundings.

When I was first starting out, I fell into the trap of 
making things a little too gritty. I would bring the 
black levels too high, making the image feel 
cramped and lacking in detail. Since then, I have 
taken time to learn about light and how it interacts 
with the surrounding environment. Not only has 
this brought detail back into my work, but it also 
makes for far more realistic results. Organising 
with layer stacks, colour coding and correct layer 
labelling has made life much easier, and where 
possible I will put layers into a group and use a 
single mask to avoid any fringing or stray artefacts.  

THE DEVELOPMENT OF HORSFALL’S WORK
NOW AND THEN

WHAT’S YOUR FAVOURITE WORK THAT YOU 
HAVE CREATED?
Currently, I think it is ‘The Ocean’s Return’. I created it 
while on a fantastic matte painting course through 
the CGSociety. Previously, I had almost exclusively 
used photographic content to create my composites, 
but in the case of this image, I began to use far more 
brush painting skills, which becomes very helpful 
when creating fictional elements. 

WHAT PROJECTS ARE YOU WORKING ON AT 
THE MOMENT?
I am currently retouching for a leading UK 
photographic studio, while at the same time taking 
some training courses in 3D and compositing 

THEN

NOW

software to expand my skill set. I also have a 
personal project based on tattoos coming to life that I 
have just started, which will allow for a vast array of 
different and exciting visuals that I can tailor to my 
own specifications.

WHAT’S NEXT FOR YOU?
In September I am heading out to Los Angeles to do 
some industry networking in the States. The last six 
months have proved very positive and have 
strengthened my relationships with a number of 
individuals who could potentially help to develop my 
career. I will also be concentrating more on 
marketing and concept artwork for the film, music 
and games industries.

20 new courses now available       www.media-courses.com      020 7138 2909

Learn Photography in
Central London
Day - Evening - Weekend
Beginners welcome

• Portrait
• Lighting
• Black + White
• Re-touch advanced

• Fashion
• Wedding
• Still Life

for a new career
Shoot 25%

discount
if you book

early
London Academy of
Media Film and TV
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DISCOVER HOW TO CREATE LINOCUT ARTWORK, 
THEN PERFECT THIS INSIDE ADOBE PHOTOSHOP

LINOCUT PRINT

O ne of the best things about working in 
linocut is that it’s a process that 
encourages you to approach your work in 
a different way. Artists have to adapt their 

methods to fit in with the peculiarities of the 
materials, which can often result in your work taking 
an exciting new direction.

The marks made by the blade you use are thicker 
and less easily controlled than marks made by a 
pencil or pen and they are also extremely stylised 
and distinctive, which is why many digital artists aim 
to replicate the same look. 

After the design has been cut, the printmaking 
process creates some fascinating accidents and 

irregularities. Because of this, linocut artwork can 
work well with digital media. 

Photoshop is a great way to try a reductive 
approach to lino cutting. Reductive printmaking is a 
method in which one colour is printed and some 
more of the lino cut away before another one is 
made. Instead of printing each stage on top of the 
last, you can print them separately and combine 
them as layers in Photoshop. 

This gives you more control over the final image, 
but still retains the charm of handmade artwork. 
Read on to find out how to do all this using our 
expert advice, supplied by illustrator Abi Daker 
(www.abigaildaker.com).
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ON THE DISC
TUTORIAL FILESRESOURCE PROJECT

ESSENTIAL TOOLS FOR LINOCUT
SEE WHAT YOU NEED AND WHAT IT’S USED FOR

BLADES
A sharp metal blade is used to make cuts in the lino. 
Again, there are a variety of sizes and shapes 
available, so it’s worth experimenting with different 
kinds to see what sort of marks you can make.

LINO SURFACE
Lino is the surface you cut into and print from. There 
are a number of different kinds of lino surfaces 
available and each gives a different print quality, so 
try them out.

INK TYPES
You can buy oil-based and water-based types. 
Oil-based ink dries slowly, but is harder to clean. 
Water-based ink is slightly easier to use, but can dry 
quickly if you leave equipment unattended.

INK ROLLER
The ink roller is used to apply media onto the surface 
of the lino design you’ve just produced. It’s important 
to keep the roller clean at all times, ensuring an even 
layer of ink across your printing surface.

LINOCUT PRINT   ON THE DISC

ABI DAKER
www.abigaildaker.com

OUR EXPERT

Daker is an illustrator and artist 
who specialises in travel and 
architectural subjects, particularly 
illustrated maps and city skylines. 
She uses both traditional and 
digital media in her work and 
clients have included The New 
York Times, Red Bull and Sony.

The marks made by 
the blade are stylised 

and distinctive, which is 
why many digital artists 
replicate the look

CUTTER HANDLE
Blades are attached to a lino cutter handle. They are 
screwed into the top of the grip and must be done so 
carefully to avoid any accidents. The handle should 
feel comfortable for you to hold while cutting.
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Produce linocut artwork
How to cut and print by Hand

01 Draw out your Design
Draw your design onto the lino. Remember 

that the image will print in reverse, so if it’s important 
that your design faces a certain way, you’ll need to 
work from a reversed source image. You can either 
flip your source image horizontally on the computer 
or draw your design on transparent tracing paper. 

02 Cut out your Design
The areas of the lino you cut out will print 

as white, so bear this in mind before you start. Hold 
the cutter carefully and start by applying small 
strokes into the lino. Keep your cuts shallow at first. 
If you need to remove more, you can do so later, but 
a deep groove is difficult to fix. 

03 aDD texture
The areas you remove can become an 

interesting part of the design if you think carefully 
about the strokes you make when you are cutting. In 
this design, slight variations in the angles of the cuts 
add a subtle crosshatch effect. 

04 take an early test print
It’s a good idea to take test prints 

throughout the cutting process. It will help you to see 
how the design is progressing and to get an idea of 
how your mark-making will translate into print. 
When you are working on your design digitally, test 
prints can be an interesting thing to play with.

05 roll your ink
You should make sure that your ink is rolled 

out evenly across the surface of the lino. Also make 
sure that you’ve applied the right quantity of ink, as 
this will determine a good print. Too much ink will 
make the image appear splodgy, while too little ink 
will look patchy. 

06 print, praCtise anD experiment
Once you have the paper laid over the inked 

panel, make sure you press evenly all over so that 
your image transfers completely. The key to 
mastering the print stage is to practise – get to know 
your materials and how the ink works with different 
kinds of paper.

on tHe disc    Linocut print

Get to know your 
materials and how 

the ink works with 
different kinds of paper
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01 Scan and tidy your artwork
Take high-resolution scans of each stage of 

your printing. Use the Brush and Healing Brush tools 
to remove any unwanted marks or smudges in your 
design. Select View>Rulers and add guides and the 
Free Transform tool to straighten each image.

02 Layer your fiLeS
Copy and paste each image into a single 

file, stacking each version of your print on top of one 
another. Set each layer’s blending mode to Multiply 
to line up layers evenly. If you want to remove white 
areas from any layers, use Select>Color Range.

03 try out Layer effectS
You can now recreate the effects of multiple 

colour lino prints, but with greater control than is 
allowed with any physical medium. Try out different 
layer combinations and blending modes until you 
create an image you are happy with.
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Digitise your Design 
ScAn AnD eDit your linocut printS
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ON THE DISC    LINOCUT PRINT

DERRICK CASTLE
http://strawcastle.com/

OUR EXPERT

Derrick Castle spent a 
lot of time thinking 
about how he missed 
the hands-on approach 
to design. He soon 
turned to linoleum, as 
he explains: “I love the 
nature of this type of 
printing. All its 
imperfections give each 
print so much 
character. I start with 
an illustration, which I 
transfer to my linoleum. 
From there I ink out my 
negative space and 
start the long but 
therapeutic process of 
carving. All the work 
pays off when you 
press your first print.”

ZOE MIRZA
http://zoemirza.tumblr.com/

OUR EXPERT

This typography was created by Zoe Mirza, as a piece of 
self-promotion to showcase her strong interest in handmade 
design. “It’s important to preserve human qualities in the 
digital world, so I like to experiment with traditional printing 

processes,” she explains. However, the starting point for this design started as a 
rough draft in Photoshop, using a standard font. “I then carved it out of a 
rubber lino block,” she reveals. “The final image was hand printed using 
water-based inks onto card and became the dust cover of my promotional booklet.”

SUMAYA MAHADEVAN
www.behance.net/fayereve

OUR EXPERT

Ancient Asian masks inspired this 
image. Mahadevan explains: “I 
chose the art of lino print for it’s 
gritty and rustic charm, which 
added to the handcrafted integrity 
of the design. I love the idea of 
paying tribute to the older 
methods of image making.”
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Texturevault.net provides high quality, 
creative textures and backgrounds that you can 
use in your creative work. This issue they have 
supplied you with ten linoleum textures.

Texturevault.net
creative textures and backgrounds that you can 
use in your creative work. This issue they have 
supplied you with ten linoleum textures.
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LANDSCAPE TIPS SHOOTING ADVICE CAMERA REVIEWSPORTRAIT GUIDES

Available 
from all good 

newsagents and 
supermarkets

WILDLIFE PHOTOS

Learn to inspire
www.dphotographer.com

BUY YOUR ISSUE TODAY
Print edition available at www.imagineshop.co.uk

Digital edition available at  www.greatdigitalmags.com

facebook.com/DigitalPhotographerUK twitter.com/DPhotographer

ON SALE NOW
> Master landscapes > Shoot in high key > Wildlife photography

Available on the following platforms







Learn in style

Edit images • Create stunning graphics • Enhance photos 

®®

The ultimate guide to becoming an expert Photoshop user

Volume 3

001_PPB_03_Cover.indd   3 13/06/2013   16:17

Discover more with the Book series’ expert, accessible tutorials for 
iPad, iPhone, Mac, Android, Photoshop, Windows and more

The

Series

TM

BUY YOUR COPY TODAY
Print edition available at www.imagineshop.co.uk

Digital edition available at www.greatdigitalmags.com

facebook.com/ImagineBookazines twitter.com/Books_Imagine

Available on the following platforms
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